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Multi-Site Checklist

Follow this checklist when implementing a new multi-site system. Each step has a corresponding
chapter that describes the step in detail.

Note: If you are using Infor CloudSuite Industrial in the Cloud, ask your cloud administrator or
consultant which steps apply to you.

1. Plan: N/A

e See the Multi-Site Planning Guide - Create spreadsheets and
flowcharts.

e Decide whether transactional or non-transactional replication will
be used.

2. Set up the database server: Database

e Install Infor CloudSuite Industrial and create one application server
database.

e Depending on how you plan to set up your system, either create
additional application databases for sites/entities, or add sites/
entities to your existing application database. Use the Infor
CloudSuite Industrial Configuration Wizard.

e |f you are using one site per database, link the databases with Infor
CloudSuite Industrial Configuration Wizard.

e If you are using multiple sites per database, add or copy the
additional sites/entities into the application database.

Infor CloudSuite Industrial - Multi-Site Implementation Guide | 7



Multi-Site Checklist

3. Set up the utility server: Utility server
e Install and configure Infor CloudSuite Industrial.

Create additional client configurations for other sites/entities - Infor
CloudSuite Industrial Configuration Wizard.

Add web servers used by the configurations.
Define configuration groups.
Update Service Configuration Manager utility settings to:
Set up monitoring of configurations for events
Set up monitoring of configurations by TaskMan
Set up a replication configuration (non-transactional only)
Restart the services.
Use one console to administer all sites/entities.

4. Set up end user clients. Utility server
or client
machines

5. A Set up transactional replication: Sites and
e Set up replication links - Intranets form, Sites/Entities form. Entities

e Update views and triggers if linked sites/entities are in different
databases.

e Set up replication categories and rules - Replication Categories
form, Replication Rules form, Replication Management form.

e Populate parameter _all records at other sites.

5.B Set up master site and shared _all tables: Sites and
e Set up transactional replication (above). Entities

e Set up the master site - Intranets form, Sites/Entities form, Intranet
Shared Tables form.

5.C Set up non-transactional replication: Sites and

e Create replication user - Users form, User Modules form (requires | Entities
license).

e Set up system types - System Types form.
e Set up replication links - Intranets form, Sites/Entities form.

e Update views and triggers if linked sites/entities are in different
databases.

e Set up replication categories and rules - Replication Categories
form, Replication Rules form, Replication Management form.

e Populate parameter _all records at other sites.
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Multi-Site Checklist

6. Set up licensing: Sites and

e If using intranet licensing, turn it on at the master site and any Entities
participating sites and entities - Sites/Entities form.

e License modules for a database on the License Management
form.

e Enable modules for a site on the Optional Modules form.

7. Set up financial reporting hierarchy: Sites and

e Change Reports To Entity form Lower-level
Entities

Set up accounts: Top-level
e Multi-FSB (optional) Entity
e Chart of Accounts form - add all accounts; add CTA account
e Multi-Site Chart Copy form - copy COA to mid-level entities
e Unit Code 1-4 forms
e Copy Unit Codes to Accounts form
e Accounting Periods form
e Set up financial statements - Financial Statement Definition,

Financial Statement Definition Columns, and Financial Statement
Line Definition forms.

Set up accounts: Mid-level
e Multi-FSB (optional) Entities
e Chart of Accounts form - specify Reports To account information

e Unit Code 1-4 forms

e Copy Unit Codes to Accounts form

e Accounting Periods form

e Verify Accounts To Report form

e Set up financial statements (only if mid-level entities will run them).

Set up accounts: Sites

e Multi-FSB (optional)

e Chart of Accounts form - delete accounts that don’t apply

e Unit Code 1-4 forms

e Copy Unit Codes to Accounts form

e Accounting Periods form - just specify current period

e Set up financial statements (only if sites will run them).
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8. Set up parameters and codes needed for later steps: Sites and
e Set up site groups - Site Groups form. Entities (some
information

e Set up countries and states - Countries form, Prov/States form.

e Set up currency - Multi-Currency Parameters form, Currency
Codes form, Currency Rates form.

e General Parameters form

will replicate)

Set up bank codes: Sites
e Bank Reconciliations form

Set up system parameters: Sites
Inter-Site Parameters form

Accounts Receivable Parameters form
Accounts Payable Parameters form
Order Entry Parameters form
Purchasing Parameters form

Transfer Order Parameters form
Planning Parameters form

Inventory Parameters form

Other parameter forms as needed

0. Set up users and authorizations: Sites and

e Set up sharing of user tables at the master site - Intranet Shared Entities
User Tables form (optional).

e Add "Enter Out of Date Range" group for "sa" user - Users form.
e Set up parameters for passwords - Password Parameters form.

e Set up other users - Users form, Object Authorizations for Users
form, User Modules form (if using intranet licensing, run User
Modules only at master site).

e Set up any external customers or suppliers who will log in remotely
via the internet as users on particular sites.

10. Set up supporting data: Sites

e See the list of forms in this step. The forms you use depend on
your company’s requirements.
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Multi-Site Checklist

1.

Set up operational data:

e Add common customers - Customers form or Multi-Site Customers
form.

e Add common vendors - Vendors form or Multi-Site Vendors form.

e Add common items - Items form or Multi-Site Items form, Global
Items form.

e Set up employees - Employees form.

e Set up other operational data - see list of forms in this step. The
forms you use depend on your company’s requirements.

Sites

12.

Set up add-on products and modules.

Depends on
the product
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Chapter 1: Planning

Follow these steps to plan your multi-site implementation:

1 See the Multi-Site Planning Guide. When you complete the steps in that guide, you will have
spreadsheets and flowcharts containing most of the information you need to install and configure
your sites. You can then update the spreadsheets to track changes as your system grows.

2 You must know which type of replication you are using before you set up your system, because
some steps apply only to one type or the other:

e Non-transactional replication, as used in this guide, refers to any inbound or outbound
asynchronous replication. This can include applications that integrate with Infor CloudSuite by
posting data via XML documents into the Infor CloudSuite sites, as well as Infor CloudSuite
sites using XML to communicate with each other. Infor CloudSuite Enterprise Financials and
EAM would fall into this category.

e Transactional replication, as used here, generally means that sites and entities are on the
same database server and are replicating records through database triggers and stored
procedures as soon as the records are added or changed on one site. The use of master sites
and intranet shared tables requires much of the same setup as transactional replication.

3 Strongly consider setting up a test environment and making sure everything works properly
before setting up your production environment. See Appendix B, “Setting Up a Test Environment,"
for more information.

Note: Be aware that this guide is intended for both cloud and on-premise versions of Infor
CloudSuite. However, cloud users cannot perform all tasks that are described here. Cloud or hosted
users should contact their business partner or Infor CloudSuite consultant regarding any task that
involves access to the utility server or the database server.
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Chapter 2: Setting Up the Database
Server

Install Infor CloudSuite Industrial and Create an
Application Database with One Site

Note: If you plan to set up multiple sites in one database, your database server must be running
Microsoft SQL Enterprise Server and the database you create is automatically partitioned.

On each SQL server machine where you will be adding site or entity databases, follow the steps in
the Infor CloudSuite Industrial Installation Guide chapter "Setting Up the Database Server" to install
the application and do the following:

e Create one initialized application database.

If you plan to set up multiple sites in one application database, name the database appropriately,
taking into account any other sites/entities that you plan to add to it.

e Use your SiteEntity spreadsheet (from the Planning phase) to enter the site information when
configuring the application database.

e Create at least one forms database for your system. Your SiteEntity planning spreadsheet should
indicate how many forms databases you need and what to name each one. Later, on the utility
server, you will specify which forms databases are used with which application databases.

e Create at least one objects database for your system. The SiteEntity planning spreadsheet should
contain the information you need for this. Later, on the utility server, you will specify which objects
databases to use with application databases.

If you plan to set up multiple sites per database, only one objects database is allowed for those
sites.

After you create one application database, one forms database, and one objects database, return to
this chapter to perform additional steps. At this point, you will either:

Option Page

Create additional sites and entities in separate databases and link them together. 16
Continue with “Create Additional Site and Entity Databases.”

Create additional sites and entities in the same application database. Skip to “Add New 21
Sites and Entities to an Existing Application Database.”
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Setting Up the Database Server

Create Additional Site and Entity Databases

To add multiple application databases on each database server, with one site or entity in each

database:
1 Run the Configuration Wizard again. (Run as Administrator.)
2 Select Create Databases and click Next.
Welcome!
‘welcome to the Infor CloudSuite Configuration Wizard, which will guide you through
the configuration process. The list below shows all of the components that can be configured
on thiz server. Select any components that you wish to configure at this time and click Mext
when pou are ready to continue.
Component To Configure Create various database types.
Create Datab
[ Link D atabases for Multi-Site Uze
] &dd Mew Site to an Existing Database
LCancel | | Mest » | |
3 You can add all of the site and entity application databases in one session. Just click the Add

button again after defining each database.

Summary of Databases to Create

Use the Add, Edit, and Remove buttons to madify the list below. ‘when vou click the &dd
button, you will be asked what type of database to create.

Mame Type |
Initislized Application D atabaze

Edit

Bemove

I

Lancel | < Back | Mest » |

a When prompted for the database type, select Initialized Application Database This is true
for either site or entity databases. (The only times you would choose Empty Application
Database instead is if you are migrating from a Progress database, or if you are upgrading
from a SQL version of Infor CloudSuite and are copying multiple sites into a single database.)

b On the Database Name and Location screen and the Set Database Site Parameters screen,
enter the application database information from your SiteEntity planning spreadsheet. The
SQL Data File Path and Log File Path are generally just defaulted in for application
databases. The SQL User defaults to the "sa" user.

¢ Click Next to return to the Summary screen with the new database listed.
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Setting Up the Database Server

4 Click Next to review and then Commit the configuration changes. If you are creating several
databases, this step may take some time to complete.

5 Click Finish to close the wizard.

Link Databases

Note: Perform the steps in this section only if you plan to use transactional replication to replicate
data to or from sites/entities in application databases located on this database server.

After you have defined all your databases, link them so they can communicate with each other.
Follow these steps:

1 Run the Configuration Wizard again. (Run it as Administrator.)

2 Select Link Databases for Multi-Site Use and click Next.

Welcomel

‘welcome to the Infor CloudSuite Configuration Wizard, which will guide you through
the configuration process. The list below shows all of the components that can be configured
on thiz server. Select any components that you wish to configure at this time and click Mext
when pou are ready to continue.

Component To Configure Wllows databases to be linked into
[ Create Databases multi-site configurations.

LCancel | | Mest » | |

3 When you first enter the Link Multi-Site Databases screen, there are no databases listed. Specify
a Group Name for the set of sites/entities on this machine that you want to link together. Use the
group name from your SiteEntity spreadsheet.

Link Multi-Site Databases H

Enter a group name, then uze the Add/E dit/Femove buttons to select databases to be linked
inta a multi-gite configuration uging this group name.

Group Mame: Cam|

Mame Site Information | Add

Lancel < Back | Mest » |
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Setting Up the Database Server

Every time you run the Configuration Wizard, the first time you display this screen, the list of sites/
entities will be blank - even if linked databases already exist in the group you specify. To add a
new site/entity to an existing group, you must re-add all of the sites/entities here. This sets up
each database for multi-site communication and links it to all of the other databases that are
added at the same time.

Note: Later, in the application’s Site Groups form, you can add more groups or change the groups
to which a site or entity belongs.

4 For each site or entity that you want to be linked, click Add and specify the connection information
for the database:

Select Multi-Site Database H

Specify the connection information for the SyteLine Application D atabase that pou want to
link. inta & multi-zite configuration.

SOL Server Mame: |[I0c:a|] j
SOL Uszemname: |sa

SOL Password: [

Application Database to Link: ’m
Site ID: |CAN j
Site D escription: |Canada entity

Lancel | < Back | Mest » | |

e SQL Server Name: Name of the SQL Server where the application database you want to link
to resides.

e SQL Username and Password: Name and password of a SQL user who can access and
update this database. Sometimes this is set up as the sa user.

e Application Database to Link: Enter or select the name of one of the application databases
to be linked. (You will be adding the others in the next step.)

e Site ID: Select a site or entity ID in the database you specified. For single-site databases, the
site or entity ID displays.

e Site Description: the description of the the database you specified displays.
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Setting Up the Database Server

5 Click Next to return to the previous screen and add another site/entity to be linked.

Link Multi-Site Databases

Enter a group name, then uze the Add/E dit/Femove buttons to select databases to be linked
inta a multi-gite configuration uging this group name.

Group Mame: Cam|
Mame Site Information |
CAM_App on [local) CAM: Canada entity

Add
ONT_&pp on [local] ONT: Ontario Site Bemave

Lancel | < Back | Mest » | |

Note: Make sure you link only application databases (not forms or objects databases).
6 When all of the sites and entities you want to link are listed, click Next.

7 Review the changes and click Commit.

Review Configuration Changes

The configuration options you have selected are listed below. Feview the options and click.
Commit to save the changes at this time. Use the Back button to fix any ermors you find.

Linking the CAN App/CAN databasefsite on (local) to the group
named CAN with ONT_App/ONT.

Linking the ONT_Aipp/ONT database/site on (local) to the group
named CAN with CAN App/CAN.

Lancel | < Back |

8 Click Finish to close the wizard.

Note: Each time you run the Configuration Wizard on either the database server or the utility
server, it appends information about the configuration changes to a log file found on that server
under

Infor\SyteLine\Tools\SLConWiz.log.

9 If you plan to perform transactional replication between sites on this database server and other
sites that are not on this database server, create a linked server definition in the SQL server
master database of both the current site and the To site. Do this with the SQL Server
Management Console: in the console tree, open the Server Objects folder for the server and
right-click on the Linked Servers node.

This should match the list of linked servers you added in the Configuration Wizard.
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Setting Up the Database Server

Note: If all sites are on one database server, or if you are not using transactional replication, you
can skip this step.

About Linking Databases

Whenever you add a new site to an existing transactional multi-site environment, you must relink
all sites using the Configuration Wizard. If you create and configure the new site by itself, it will
prepare that database for multi-site work, but it will not know about other existing databases.

Although the databases do not all have to be on the local server, transactional replication is much
more efficient when they reside on the same server.

You can run the wizard again to add more links later if needed.

When you link multi-site databases with the Configuration Wizard, the following things are altered
in the databases:

e site table: new entries are added or updated.

*

_all tables: row pointers are altered, foreign keys are temporarily dropped, tables are
truncated and repopulated, and foreign keys are reapplied.

e ApsResyncAllSp runs against each database.
e site_group table: new entries are added or updated.
e site_live_link table: new entries are added or updated.

If you plan to use transactional replication between all the sites and entities in each reporting
hierarchy or intranet, but also use non-transactional replication between sites in different reporting
hierarchies or intranets, you should create a group for each reporting hierarchy or intranet and
link together the sites/entities in each group. So you would run the wizard multiple times to create
multiple linked groups.
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Setting Up the Database Server

Add New Sites and Entities to an Existing Application
Database

Use your SiteEntity spreadsheet (from the Planning phase) to enter the site information when adding
and configuring sites and entities.

To create a new site or entity in the application database you created earlier in this chapter:

1 Prevent users from accessing or making any changes in the target databases during this process
2 Open the Configuration Wizard. (Run as Administrator.)

3 Select Add New Site to an ExiJsting Database and click Next.

Welcomel

‘welcome to the Infor CloudSuite Configuration Wizard, which will guide you through
the configuration process. The list below shows all of the components that can be configured
on thiz server. Select any components that you wish to configure at this time and click Mext
when pou are ready to continue.

Component Ta Configurs Wllowes & resw site to be added to a
[ Create Databases database.

ng D atabase

LCancel | | Mest » | |

4 In the Select Source Type dialog box, select Initialized Application Site and click Next.

Select Source Site Type
Specify the zource site type and information to facilitate a copy to the target.

" Database

SOL Server Mame: |[Ioc:a|] J

SOL Username: [sa
SOL Pazsword: [
SOL D atabase: |
Site ID: |

Lancel | < Back | Mest » | |

LdLed
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Setting Up the Database Server

5 Inthe Set Site Parameters dialog box, specify this information for the site, from the information in
your SiteEntity planning spreadsheet:

Set Site Parameters H

Specify the enterprize specific information for the Source data.

Site 1D: [

Site: Mame: [ lingis

Site D escription: [ linois site

Site Group: |FIN|

Site Currency: [USD: US Dallar |
Site Type: |site &
Time Zane: | (UTC-08:00) Central Time [US % C |

Lancel | < Back | Mest » | |

e Site ID: Specify an ID, which can be a shorter version of the site name (8 characters
maximum).

e Site Name: Specify a name for the site.
e Site Description: Specify a description for the site environment being created.

e Site Group: Specify a group name for the environment being created. The group name
should be descriptive of the sites in the group. For example, you might have a group name of
"NoAm" for North America if all the sites in that group are in North America.

e Site Currency: Accept the default value of USD or specify the appropriate currency code for
the environment.

e Site Type: In most cases, accept the default value of Site. Select Entity if you are setting up
a financial entity to consolidate data from the sites.

e Time Zone: Specify the time zone for the site.
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database that you created earlier.

In the Set the Target Database Information dialog box, specify information about the application

Do not select Analyze Only; that field applies only when you copy existing sites from other

databases.

Do not select Delete Target Database Data; that field applies only if you want to empty the data
from the specified target database. This is only necessary in the specific case described on page

147.

Set the Target Database information

Specify the enterprize specific information for the Target Databaze.

SOL Server Mame:

SOL Username:

SOL Pazsword:

SOL D atabase:

SOL Server Partitioning Status:
S0L Database Partitioning Status:
[~ Delete Target Database Data

Lancel |

[flocal) ~|

[sa

|Partiti0ning supported

|N0t Empty, Partitioned
[ Analyze Only

< Back | Mest » |

7 Click Next.

8 Review the changes and click Commit.

Review Configuration Changes

The configuration options you have selected are listed below. Feview the options and click.
Commit to save the changes at this time. Use the Back button to fix any ermors you find.

'Syteline App'.

Site 'ILL' will be created on the Target databasze

Lancel

< Back |

9 Click Finish.

10 To add more sites or entities to the application database, reopen the Configuration Wizard and

repeat the steps above.
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Install Infor CloudSuite and Configure Components

On each utility/Web server machine where you will be creating configurations, follow all the steps in
the Infor CloudSuite Industrial Installation Guide chapter "Setting Up the Utility Server." These steps
will:

e Install the application.

e Create an initial configuration on the utility server that links to one site database, using one of the
configuration names you specified during your Planning phase.

e Set up the various Web services (lIS-based) on the utility server. These are used by clients
connecting using http protocol, by the online help, for non-transactional replication, for integration
with some applications, and so on.

e Set up Web rendering, if appropriate.

e Set up the TaskMan service for the utility server.

e Set up replication services on the utility server.

Note: Replication services are needed only if any of the configurations to be defined on this utility
server will be running non-transactional replication.

Set up a Planning and Scheduling gateway and server (used only with APS).

Set up Reporting Services so that you can print and preview reports.

Set up the Application Search Web service, if appropriate.

Through the Service Configuration Manager, set up monitoring of that first configuration by the
TaskMan, replication, and event services.

e Set up an administrative client on the utility server that points to a specified URL. This URL is the
utility/web server where the various configurations will be defined.

Then return to this chapter for the following additional steps to create configurations for the rest of
your sites and entities.
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Create Additional Client Configurations

You must add a client configuration for each site and entity database you want to access through this
utility/web server.

Caution: If you have multiple utility/web servers, only one of them should be designated as the Con-
figuration Server, and the Configuration Manager utility should be run only on that Configuration
Server. The resulting MongooseConfigs.xml file should then be copied to the other utility/web serv-
ers so they have access to the defined configurations. See the Multi-Site Planning Guide for infor-
mation about the Configuration Server.

For each site and entity, create one configuration name that exactly matches the site ID, including
case, and that uses the site’s application database. This is required unless you specify a different
default Configuration Name on the Sites/Entities form. (You can create additional configurations for
the site or entity, with different names.)

1 On the utility/web server, open the Configuration Manager (Run as Administrator). For most
operating systems, navigate to Start > All Programs > Infor > Tools > Configuration Manager.
For Windows Server 2012, find Configuration Manager under Apps. The Configuration Manager
displays the initial configuration that was created during installation and setup of the utility/web

server.
v Configuration Manager I;Ii-
Configurations |Applications ‘wieb Servers | Configuration Groups | Lltilitie:s |
To create a configuration, click Mew. For other actions, first select a
configuration on the left, and then click the appropriate action button,
Configuration Mames:
Actions
WinStudio ...
FarmCantral ..
Help
| Path: C:A\ProgramD ata‘Mongoose

2 Click New to create a new confguration.

Mew Configuration -
Configuration Mame: |ILL| |
QK | | Cancel | | Help |
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3 Enter the new configuration name and click OK.

4 In the Runtime (Client) tab, define the application and forms database connection information for
the new configuration:
Runtime (Client] | FarmContral | Obijects tMetadata | Source Eontrol|
Funtime Application D atabase [Required] Runtime Forms D atabase [wWinStudio]
Database Type: [Microsoft SOL Server v] Database Type: [Microsoft SOL Server v]
Paszword; == Paszward; ==
Server USCOVWLO Server USCOWWLO
Database Mame:  OH_app - Database Mame:  OH_Forms -
Mizc. Connect Info: Mizc. Connect Info:
Query Timeout: 0 Query Timeout: 0
Site FormTemplates Database Mame
Iy - -
Tools User Mairitain Winstudio 'sa' user
User: [ Change ... ] [ Set password ..
Application Scripting Code Security
MEI01 - _ [ Smart Client Scripts Run In Partial Trust
[ web Cliert Seripts Run In Partial Trust
Note: Use the information from your SiteEntity and Configurations planning spreadsheets to help
you fill in access information (SQL server name, login, password, and database name) for the
application, forms, and objects databases.
5 In the Objects Metadata tab, click Set Objects DB Specification and then specify the Objects

database name.
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Note: You can associate only one Objects database with an application database. So if you have
multiple sites in one application database, make sure that all configurations for sites in that
database point to the same Objects database.

] Edit Configuration - ILL | x|

| Runtime [Client) | FormEontr0I| Objects Metadata | Source Contral |

100 Objects DB Specification [Fequired) Source Control
The following objects database server and databaze are ) ' Set Objects Metadata Server/Database
to define views and to designate a server link between the
application and objects databagzes. To designate a differe
server and database, click the button below.
Specify a SAL Server and D atabase name for the D0 Objects metadata
database. A valid Uzer and Pazsword will be required to validate the
Server: |USCU\"W|0 Objects metadata database.

D atahase Mame: |SyteL|ne_Db|eCts Mote: Pressing ‘0K to accept the Server and Database specified will drop

and recreate all Views to the Objectz DB in the Application D atabase.

Set Objects DB Specificatil Additionally, if the Server specified is different fram the Server of the

Application DB, a Linked Server definition will be set up as well.

Database Twpe: | Microsoft SOL Server

Server |uscovwl0 |

[atabaze Mame: |SyteLine_Dbiec:ts v|
1]
| QK | | Cancel | | Help

6 Click OK. A confirmation message displays; click OK again.
7 If you use FormControl or a source control system, set up information on those tabs as needed.

8 Click the OK button at the bottom of the Edit Configuration screen to save the configuration and
return to the Configurations tab, where the new configuration displays:

v Configuration Manager | = | = [

Canfigurations |Applications | Wweb Servers | Configuration Groups | Utilities |

To create a configuration, click Mew. For other actions, first select a
configuration on the left, and then click the appropriate action button,
Configuration Mames:

D efault Actions

=]
Edit ...
Copy ...
Delete ...
Import ...

Export ...

WinStudio ...

FarmCantral ..

Help

:

| Path: C:A\ProgramD ata‘Mongoose

9 Repeat steps 2 - 8 until all configurations are defined.
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Note: If a new configuration definition will be very similar to an existing one (for example, if just the
application database name is different), you may want to use Copy instead of New. This creates a
copy with a new configuration name and you then select Edit to modify the definition.

You must manually specify the Objects database in each copied configuration.

Add Web Servers Used by the Configurations

If you have multiple web/utility servers through which your clients can access the configurations,
define them in the Web Servers tab of the Configuration Manager. They will be accessed in round-
robin order as session requests come in to the Configuration Server. (See the CAUTION on page 26
about running the Configuration Manager utility only on the Configuration Server.)

Note: Do not include DMZ servers in this list.

1 Click New.
v Configuration Manager I;‘i-

‘ Configurations | Applications | “web Servers | Configuration Groups | Ullhlles|

To create a Web Server definition, click New. For other actions, first select
a'web Server an the left, and then click the appropriste action button.

wieh Servers:

Wweh Server Name Status Actions

Enabled

e
Edit...
Copy...

Delete:

Export ...

=
z

/

Help

| Path: C:4ProgramDatabManganss

2 Enter a logical name for the web/utility server, and click OK.

New Web Server -

‘web Server Mame: ‘uscuwmcfuzzﬂ |

ak. | | Cancel ‘ | Help ‘
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3 Enter the http address of the web/utility server and click OK.

] New WebServer - uscowmcfuzz1 -

Web Server Location/Runtime Status

Enter the Root URL to this Web Server. & Relative Application path will be appended to this the Root
URL at Runtime to obtain a full URL to a Web Server Application instance.

Root URL: |htlp'.ffuscnwm:fuzz1 o |

[] Disabled

ak | | Cancel | | Help ‘

4 The server is added to the list of web servers the configurations can access.

v Configuration Manager |;|£-
Configurations | Applications | "Web Servers | Configuration Groups | ummeg\
To create a Web Server definition. click New.  For ather actions, first select
aiweh Server on the left, and then click the appropriate action buttan.
“web Servers:
‘wieh Server Name Status #ctions
‘wiehServer Enabled

Define Configuration Groups

You should have determined during the Planning phase whether you will have multiple configuration
groups. If so, select the Configuration Groups tab in the Configuration Manager utility.

v Configuration Manager [= [ o [
| Configurations | Applications | wieb Servers| Configuration Groups | Utiliiies

Configuration Groups:

=- Vefault Actions
Default Mew...

ILL

30 | Infor CloudSuite Industrial - Multi-Site Implementation Guide



Setting Up the Utility Server

Click New or Edit to display a dialog where you can define new groups and add configurations to
them. The configurations must already be defined on the Configurations tab.

Edit Configuration Group -

Mame: |Default |

Drescription: Configuration names vizible to clients that
connect without a group name.

Group Members

Default Select Al
ILL
| QK | | Cancel | | Help |

Configuration group names can contain only alphanumeric characters and the underscore character.

The Default group is predefined and cannot be deleted (but it can be edited). This group initially
contains every configuration. If there are no configuration groups defined in your current
configuration file (MongooseConfigs.xml), you will still see the Default group containing all
configurations. Whenever you create a new configuration, it is added to the Default configuration
group. If clients request configurations and do not specify a configuration group (or specifies
"Default"), they will be presented with only configurations in the Default group.
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Update Service Configuration Manager Settings

When you add configurations, you need to update the Service Configuration Manager utility so that
the new configurations will be monitored by Infor services such as TaskMan, Replication, and the
Event System.

Open the Service Configuration Manager on the utility server. (Run as Administrator.) For most
operating systems, navigate to Start > All Programs > Infor > Tools > Service Configuration
Manager. For Windows Server 2012, find Service Configuration Manager under Apps. .

s AEE]|

General | Event Service | Replication | TaskMan

Drefault
Canfiguration File Path: | C:\Documents and Settingshall Uzers\Application D ata‘\MongoozehtongooseConfigs. sml

Default Canfiguration: | [LL 1"

Installed Services

Infior Framework, ID0 Runtime Service

Itfor Framewark, Event Service

Infor Framework, Replicator

Infar Framewaork Replication Husue Listener
Infor Framewaork. TaskiMan

Ifor Framewark, Inbound Bus Service

Config Server

Config Server URL: | hitp:/AuckAADOR equestS ervice/ConfigS erver. azps

[ Save ] [ Exit ] [ Help ]

The General tab shows what services are installed on this utility server and where to find
configuration files. You can also specify a default configuration here, but currently it only applies to the
Replication services.

Use the Config Server URL field to specify the URL to the configuration server.
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Set Up Monitoring of Events for Various Configurations

Use the Event Service tab on the Service Configuration Manager to specify each of the configurations
you want the Event System to monitor.

&1 Service Configuration Manager

General | Event Service | Replication | TaskMan

Configurations

ILL Add...
Edit...

Delete

See the Multi-Site Planning Guide for information about monitoring configurations for events. You
may have created an Events spreadsheet as part of your planning process.

1 On the Events tab, click Add to display a dialog box where you can select a configuration and
optionally specify sleep time (defaults to 10 seconds) and the maximum number of concurrent
events that can run in this configuration (defaults to 5). For more information, see the Service
Configuration Manager online help.

vent Service

Configuration: | CAL w
Sleep [seconds) ||

Max. Threads:

[ Ok ] [ Cancel ]

2 Repeat Step 1 for all configurations you want the Event System to monitor. Usually you will select
all configurations for monitoring.

3 Click the Save button at the bottom of the window to save your changes. The system will not
recognize the changes until you stop and restart the services later in this chapter.

Set Up TaskMan Monitoring of Configurations

Set up TaskMan to monitor configurations for any application database on which users will be
executing reports, stored procedures, IDO methods, executables, or other background tasks. Include
entity application databases, since financial reports can be run on them.

See the information on TaskMan monitoring of sites in the Multi-Site Planning Guide.
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1 Go to the TaskMan tab of the Service Configuration Manager.

&1 Service Configuration Manager

General | Event Service Heplicationl TazkMan

Configurations

Edit...

Delete

2 Click Add to display a dialog box where you can select a configuration and optionally a DSN.
(DSNs are only needed for some custom reports created in previous versions. See the Service
Configuration Manager online help for more information.)

Configuratior: v

DSM: | |

3 Click OK. The configuration is added to the list in the TaskMan tab.
4 Repeat steps 2 and 3 until you have added all the configurations you want TaskMan to monitor.

5 Click the Save button at the bottom of the window to save your changes. The system will not
recognize the changes until you stop and restart the services later in this chapter.
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Set Up Replication and BOD Options

On the Replication tab, configure the options used in non-transactional replication and in BOD
replication.

l Service Configuration Manager

General | Evert Service | Replication | Taskian

Fieplicator
Configuratior: | |LL w
[Dead Messages Directory: Browsze...
Use Default Directary
Retry Queue Directany: Braowse...

Use Default Directory

Site Retry Delay [zeconds]:

Meszage Editor:
Failure Matification
& Mone
O E-mail E-mail Address:
O Event Event Mame:

Motification Sender Address:
Replication Directory: | C:ADocuments and Settings\all Users\Application Data\Mongoose

Inbound Bus

Configuration: v

[ Save ] [ Exit ] [ Help ]

Service Configuration File Path: C:\Documents and Settingsiall Users\application DatalMongooseiMongooseServiceConfigs. xml

Refer to the online help for this tab of the Service Configuration Manager for details on how to set up
these fields. Be aware of the following:

If any of the configurations defined on this utility server will be running non-transactional
replication (see the definition on page 13), specify a Replicator Configuration here. This must
be the default Configuration Name that is specified for the site on the Sites/Entities form.

The Replicator service uses this site to bootstrap itself. From this site, the Replicator can query a
list of all the other sites on its intranet, and connect to those to monitor them as well. Choose a
site at which the site and intranet definitions are completely up to date.

Each site on this utility server must have a default configuration name specified in the Sites/
Entities form. If the Configuration Name field in that form is blank, the site must have a
configuration name that exactly matches its site name. This allows the Replicator to connect to
the other sites by mapping the site name to the configuration name when it logs in.

If you set up a default configuration on the General tab, the system uses that configuration as the
replicator configuration if you don’t specify a different configuration here.

In a multi-site environment, one site per intranet collects in its replication document outbox all
outbound business object documents (BODs) generated by sites on that intranet. That site is
designated through the Replicator Configuration field.

In a multi-site environment, you designate one configuration whose application database is the
entry point for BODs sent by the Infor BOD service for all sites on the intranet. (That is, the
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replication document inbox on the site is expected to receive inbound BODs for all sites on its
intranet.) The Infor Framework Inbound Bus Service uses this site’s replication document rules
and site definitions for processing all incoming BODs. This site is designated through the
Inbound Bus Configuration field.

Click the Save button at the bottom of the window to save your changes. The system will not
recognize the changes until you stop and restart the services later in this chapter.

Stop and Restart Infor Services

On the utility server, stop and restart the services so that they will be aware of any updates made in
the Configuration Manager and Service Configuration Manager.

1

Go to Administrative Tools > Services.

*3 Services

File  Action Yiew Help
= BB 2
% Services (Local)

*% Services (Local)

Select an item to view its description. Marne Description Status Startup Type Log On As
%Infor Framewark Event Service Monitars th...  Started Aukomatic Local System
Infor Framework Fax Service Monitors Fa,..  Started Automatic Local System
%Infor Framewark IDO Runtime Service Process ID...  Started Aukomatic Local System
%Infor Framework Inbound Bus Service Monitors a .., Started Aukomatic Local System
Infor Framework Replication Queue,.. Monitors th,., Automatic galga
%Infor Framework Replicator Monitors th... Automatic galga
%Infor Framework Task Man Monitors th... Automatic galga

Right-click on the Infor Framework IDO Runtime Service and select Stop. A message displays
to tell you that stopping this service will also stop other dependent Framework services.

Click OK.

When the services are stopped, restart them again, starting the Infor Framework IDO Service
first.

Note: It may be simpler to just restart the utility server machine. This automatically stops and starts all
the services.
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About the Services

Service Name When to Stop/Start

Infor Framework Event Service  When you add, edit or delete configurations, or change which
Infor Framework Replication configurations are monitored, you must stop and restart these
Queue Listener services so they recognize the changes.

Infor Framework Replicator If you change the following information for a site, you must

restart the TaskMan service:

* Forms Database Name

* Intranet Name

* Polling Interval

* Maximum Concurrent Tasks

* Maximum Concurrent Report Tasks
* Report URL

* TaskMan Path

If you change any of this information, you must restart the
replication services:

* the Intranet Name for a site
* other non-descriptive information about the site or intranet

* the password for a user who is set up in the Sites/Entities
form for use in non-transactional replication.

Infor Framework TaskMan

Infor Framework IDO Runtime Stopping the IDO Runtime Service also stops all dependent

Service services (Event, Inbound Bus, Replication Queue Listener,
Replicator, and TaskMan). When restarting the services
manually, start the IDO Runtime Service first.

When you edit or delete configurations, or change which
configurations are monitored, you must stop and restart this
service so it recognizes the changes.

When you add configurations, you can either:

* Stop and restart this service, or

* Discard the cache. On the Configuration Manager’s Utilities
tab, click Discard IDO Cache. This refreshes the list of

configuration to pick up any new configurations created since
the IDO Runtime Service was started.

Infor Framework Inbound Bus If you change the configuration used by BODs on the
Service Replication tab of the Service Configuration Manager, you
must stop and restart the service.

Infor Framework Fax Service This service, which monitors certain folders and picks up fax
control files at specified polling intervals, is not affected by
configuration changes.
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Use One Console to Administer All Sites/Entities

You should be able to log in to client configurations for each site and entity from a single console.
This will simplify the setup and administration of your multi-site system.

If some of your sites/entities are on a remote utility server, set up a remote client configuration as
described in the Infor CloudSuite Industrial Installation Guide chapter on setting up clients.
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Install and configure end user clients as described in the Infor CloudSuite Industrial Installation Guide
chapter on setting up a client workstation.

Stop before you perform the steps in the "Run Infor CloudSuite Industrial" section of that chapter, and
return to this guide. Multi-site setup has some different steps - and many additional steps - as
described in the following chapters.

Users of each site and entity need access to an end user client configuration for that site or entity.

First Time Login

1 Using the administrative client on each utility server, start Infor CloudSuite. Use the shortcut on
the desktop, or use the Windows menu to navigate to Infor>Infor CloudSuite Industrial Client.

2 Select the configuration for that site or entity, and log in as sa. Enter the password defined for the
sa user during Infor CloudSuite database server setup (page 18). This is the default password for
the Infor CloudSuite sa user; you can change it later in the application.

4# Signln

Sign In

O Use Workstation Login

|sa | |Password | I

Note: If you will be administering several site configurations from a single console, you may want to
display the site configuration name in the window’s title bar. This helps you keep track of which site
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you are currently working in. To set this up, select View>User Preferences from the Infor CloudSuite
toolbar. In the Settings dialog, select Show configuration name on caption.

Specifying a Configuration Group for a Client

When users start Infor CloudSuite, they are presented with a list of configuration names to select
from. If you set up configuration groups through the Configuration Manager utility, then you can
specify a group name as part of the client connection information:

e If aclientis using a WinStudio shortcut, you can specify the configuration group name using the
-gconfig-group command line option. For example:
WinStudio.exe -gAcme

e If aclientis connecting to the Configuration Server using HTTP, the configuration group may be
specified as a query parameter in the URL. For example:

http://slutil/IDORequestService/ConfigServer.asmx?ConfigGroup=Acme

e If you are using XML to connect, you can specify the configuration group name as part of the
GetConfigurations IDO request. For example:

<IDORequest>
<RequestHeader Type="GetConfigurations" ConfigGroup="Acme"/>
</IDORequest>

Specifying Other Startup Parameters for a WinStudio
Client

If a client is connecting using a WinStudio shortcut, you can specify additional startup parameters as
described in the "About WinStudio Startup Parameters" help topic.

40 | Infor CloudSuite Industrial - Multi-Site Implementation Guide



Chapter 5: Setting Up Replication at Sites 5
and Entities

During the Planning phase, you should have determined which type of data sharing you will use, and
which categories of data will be replicated or shared. For detailed information about how replication
works, see the Replication Reference Guide.

Type of Replication Page
Transactional Replication 42
Master site and shared _all tables 49

(Follow the steps for transactional replication first)

Non-transactional replication 53
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Setting Up Transactional Replication

Note: Skip this section if you are not using transactional replication (see the definition on page 13).

Log into each site and entity as "sa" and perform the following steps. See the online help on the
various forms for more information about any step.

Define Intranets

1 Inthe Intranets form, specify all intranets to be used in this multi-site system. The default intranet
is DEMO. You may need additional intranets. During the Planning phase you should have
determined the intranets you need and which sites will use them.

O Intranets EI @

Intranet”| SHARED

Description: | Shared Intranet O External

Transport HTTP
HTTP
Queue Serve
O Private Queue
URL:
Direct IDO URL:
Master Site:
Tenant ID:
TaskMan

TaskMan Path’™ WGRINCH1\Syteline
Report Preview URL: | hitp:#GRINCH1/reporipreview
Polling Interval:
Maximum Concurrent Tasks:
Max Report Tasks:

& Send E-mail Notification

Note: Some forms, like this one, open “filter-in-place.” Click the filter button in the toolbar to see
all existing records and add new ones.

2 If you will be sharing _all tables and using a master site, define an intranet that will include all the
sites that share tables. This cannot be an "External" intranet. All the sites on this intranet must use
the same version of Infor CloudSuite.

Note: We recommend that you specify a new intranet - not the default DEMO intranet - for this
purpose.

Do not define the master site for the intranet yet - that will be done later.

3 In the TaskMan Path field for each intranet, specify the shared path to the folder containing
TaskMan.exe on the utility server used by that intranet (usually \\servername\SyteLine). For more
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information about how this field is used, see the Multi-Site Planning Guide information on
TaskMan monitoring.

Any time you change the TaskMan Path, you should restart all TaskMan services that monitor
configurations for application databases connected to this intranet.

4 If you want users to preview report output over the internet, use the Report Server URL field on
the Reporting tab to specify the base URL path to the report output files. You will also need to
create an IIS virtual directory that maps to this Report URL.

Define Linking Between Sites and/or Entities

Use the Sites/Entities form to specify information about this site/entity and the other entities and sites
that it communicates with:

1 On the Sites/Entities form, ensure that each site/entity that was linked to the current site (see
“Link Databases” on page 17) has a record in this form. This should happen automatically.

=] Sites/Entities E=h|Ech |1
Sl Site: [CAL

1 Cal Site Mame: |CAL Site

2 CAM Diescription; | Califormia

3 CRP

4 ILL Site User Map  Link Info

5 ONT

E LS4

*

System Type:
Time Zone: | Pacific Standard Time

Intranet Name: | SHARED & Intranet Licens

Database Name: |CAL_Apg|

Forms Database Name:
Message Bus Logical ID
Tenant ID:

Report Cutput Folder:

Configuration Name:

2 On the System Info tab, select the record for each site:
a Make sure the Time Zone, Database Name, and Forms Database Name are set correctly.
b Set the Intranet Name to one of the intranets you defined on page 42.

¢ Inthe Configuration Name field, specify the name of a configuration that the system will use
as the target configuration when building IDORequest XMLs during replication and AES event
handling. If you leave this field blank, the system expects that a configuration exists with
exactly the same name as the site name, and it uses that as the target configuration.

Note: The Reports To (entity) field on this tab is display-only. Reporting hierarchies are set up
later through the Change Reports to Entity utility (page 71).
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3 Review the list of linked sites shown in the Link Info tab. If you used the Infor CloudSuite
Industrial Configuration Wizard on the database server to set up linked sites (page 17), this tab
shows those links, which are used in transactional replication between the currently selected site
record’s database and other site/entity databases.

e The local site’s record should show all the other databases linked to this site.

Infor ERP 5L {CAL)Y - Sites/Entities
Form  Actions  Edit  Wiew  Window  Help

BEHdaRIOXI@EHQ rHIEEBIEH®BIT 3 &
[E=] sites/Entities == <
St Site: | CAL
1 |CaL Site Name: |CAL Site
2 CAN Diescription; | Califormia
3 CRP
4 ILL Sustem Info Site Uszer Map | Link Info
5 ONT
3 Usa To Site gias;l‘ijclzeation Linked Server Mame
4 1 |CaN ] ISCOwWLD
2 CRP ] ISCOwWLD
3 ILL ] ISCOwWLD
4 ONT ] ISCOwWLD
5 s ] ISCOwWLD
* ]
4 »

e The records for other sites/entities should show the link to the local site.

Infar ERP 5L (CAL) - Sites/Entities
Form  Actions Edit  Wiew  Window  Help

EHDBRMOXBEA WA FHMIBE = & =B

E Sites/Entities

Sl Site: [CRP
1 Cal Site Site Mare: |CRP Entity
. CRF Entity Description: | Corporate Entity
3 ILL Sits
4 LIS, E rtity Spstem Info Site User Map | Link Info
#*
To Site gi:palkijcl:eation Linked Server Name
" CaL [l USCOWLO
* [

e The Linked Server Name is the name of the database server where the site database
resides.

e On the local site’s record, you can add any other needed links between this local site/entity
and other site/entity databases that will perform transactional replication with this database. If
you later make changes to this record, the changes can be replicated to other sites through
manual replication of the Site Admin replication category.
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Regenerate Views

Use the View Management form to regenerate table views.
1 At one site/entity in each application database, open the View Management form.

View Management

This form regenerates views for pertinent tables in the specified range.

Starting Ending

Table: - || -

2 Leave the range fields blank and click Generate.

Regenerate Triggers

Use the Trigger Management form to regenerate table triggers.
1 At one site/entity in each application database, open the Trigger Management form.

Trigger Management

This form regenerates Insert and Update triggers for the perinent tables in the specified range.

Starting Ending
Table: [| v|| v

2 Leave the range fields blank and click Generate.
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Set Up Replication Categories and Rules

1 Familiarize yourself with the default categories listed in the Replication Categories form. Be
aware of what categories are available and what each one handles. See the Multi-Site Planning
Guide for additional information about the categories.

(m| Replication Categories o |[[E [
L Category: AP
1 . Description: | Accounts Payable
2
3
4 Table Or Function Object Type Filter
5 5 »
8 2
7 3
g8 4
g 5
10 5
11 7
12 5

2 Use the default categories "as is" for now. You may want to add new categories later when your
system is up and running.

Note: Adding new categories and rules requires significant knowledge of the database and
business rules. When multiple tables are related, the order of replication can be critical.
Improperly creating and executing replication categories and rules can result in catastrophic loss
of data. Ensure that all such development and testing is performed in a controlled pilot
environment prior to implementation. We strongly suggest that you contact Infor Consulting
Services for assistance.

3 In the Replication Rules form, set up rules for the Site Admin category from this site to all other
sites and entities where replication will take place.
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Add more rules from this site/entity to other sites/entities, as appropriate.

E Replication Rules =& =
Source Site TargetSite Category i S ource Sie: |CAL
AL CAN Site Admin Target Site; CAN
2 CaL CRP Ledger Consolidation Category: |Site Admin
3 CaL CRP Site Admin Description:
4 CaL ILL AP
5 CAL ILL AR Irterval Type: | Transactional E
B CAaL ILL Centralized Order Entry £ a— 0
7 CaL ILL Inventary/ Transfers Start Interval At
4 taL I st Admin [] Disable Replication
] Cal ONT Centralized Order Entry 7] Updete ANl Colums
10 Cal ONT Inventary/ Transfers
11 CAL ONT Site Admin
12 Cal 1S4, Ledger Consclidation
13 ||CAL 1S4 Site: Adrnin |
. _ X

e For the Interval Type, select Transactional.

e You should have created a ReplicationRules spreadsheet as part of your Planning phase. You
can save time by importing the appropriate rules for each site from the spreadsheet into the
grid on the form at that site/entity. See Appendix C, “Data Load To/From Spreadsheets," for
more information.

e If a rule refers to a site/entity that is not set up with matching information in the Sites/Entities
form, the system will give a validation error when you try to save it.

e Even if a category contains _all tables that you plan to share, you generally still want to
include replication rules for the category. The shared _all tables in the category will not be
replicated; however, many categories contain additional base tables or stored procedures that
are needed to perform certain functions. (See the example on page 52.)

4 Go to the Replication Management form and click Regenerate Replication Triggers.

E Replication hManagement El@
Use these replication-related forms to set Changes to replication rules are not in
up replication rules effect until you regenerate the replication

triggers uzing the pushbutton below
Intranets

Intranet Shared Tables Reqenerate Replication Triggers

Sites/E ntitie:s

Fieplication Categories Fiegenerate views when intranet table
- sharing iz in place, and table definitions at

Beplication Rules the Master Site have changed

Manual Replication Utility
o b aster Site:

Eeplication Erors

Find Replication Setup lssue Fiegenerate iews to Master Site

Note: Finish this step for all sites and entities before continuing with the next step.

If you have multiple sites/entities per database, you can set up rules for each site and entity and then
regenerate triggers for all sites/entities in the database from one site.

Infor CloudSuite Industrial - Multi-Site Implementation Guide | 47



Setting Up Replication at Sites and Entities

Populate Parameter _All Records at Other Sites

In the Update _All Tables form at each site and entity, repopulate certain _all tables.

=] Update _ Al Tables =n Nl <
-
Select | Table Mame Meszage =
1 ana_ledger_all
2 ana_pertot_all
3 apdraftt_all
4 v apparrms_all
5 v aps_parm_all
E aptr=_all
7 aptr=p_all
8 ar_terms_due_all
9 v arparmsz_all
10 artran_all
11 attribute_group_all
12 attribute_value_all
fq n 3
Replication Category: ||nitialize _all Parameters lz‘ Disable Replication Giter lz‘
: Inchude All Sitez in Intranet
| Select Al | Truncate T ables Delete Site Records
| Deselect &l | Bepopulate T ables Delete Mon Site Records

Note: You must perform this step if the Sites/Entities form lists at least one site that is not in the same
application database, even if you are not currently replicating any data to/from that site. The form lists
only those tables that are shareable. If all of the internal sites (that is, sites on an intranet that is not
set to "External") which are listed on the Sites/Entities form reside in the same application database,
this should be an empty list.

In an initialized database, the parameters tables already have one record defined for the local site.
Because the record already exists, it will not be created at other sites through normal replication.
Repopulating the tables ensures that a parameter record for the local site exists at other sites where it
is needed. Use these steps:

1 Click Deselect All to deselect all tables in the form.

2 Select the Initialize _All Parameters replication category and click Select By Category to select
the parameters tables.

3 Make sure nothing else is selected (including Disable Replication or a Site name).

4 Click Repopulate Tables to repopulate each selected parameters _all table at the local site and
to create or repopulate the local site record at any other sites/entities to which the local site is
replicating a category that contains the parameter table.

Back Up Databases

At this point, it may be wise to back up all of your databases, so you do not have to re-add all of your
replication setup if problems occur later in the implementation.
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Setting Up a Master Site and Shared _All Tables

Note: Skip this section if you are not using a master site or intranet shared tables.

See the online help on the various forms for more information about any step.

Set Up All Sites on the Intranet

At all sites and entities on the intranet where sharing will take place (including the master site),
perform all the steps under “Setting Up Transactional Replication” on page 42 through 48.

Note: If you already have a shared master site and intranet, and you just want to add a new site to it,
see Appendix E, “Adding a Site or Entity to an Existing Shared Tables Intranet.”

Then return to this page for additional instructions.

Set Up the Master Site

Log in to the site that you want to make the master site where the shared tables will exist for the
intranet. Then follow these steps at that site only:

Note: Use a site, not an entity, as your master site.
1 Verify the information on the Link Info tab on the Sites/Entities form at the master site:

a On the Link Info tab for the master site’s record, each of the other sites on its intranet should
be listed as linked sites. For example, if the master site is ILL and the other sites on the
intranet are CRP, USA, and CAL, the local site record for ILL would list all the other sites on its

intranet.
B3 Sites/Entities
Stte o Site: ILL

1 Cal Cid Site Mame: [ILL Site

2 CAN A Diezcription: |linois

3 CRP CH

4p ILL m Spstem Info  Site Uzer Map | Link Info

[} ONT u]

g UsSa = Ta Site g::palkijclzeation Linked Server Mame

*
1 CAL O USCOwWLO
2 CRP O UsCowLo
3 Usa O UsCowLo
* O
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b On the Link Info tab for other site records on the shared intranet, the master site should be

listed. For example, when you are logged into the ILL master site, the CAL site record’s Link
Info tab would look like this:

B8 Sites/Entities

Site Si St
» oy St Name: [CAL Site
2 T8N o Description: |Califamia
3 CRP CH
4 ILL m Spstem Info | Site Uzer Map  Link Info
5 ONT ]
B USa (i To Site g:palkijclzeation Linked Server Mame
s iy JILC Ll ISCOwWLD
* |

Sites on other intranets do not require Live Link information at the master site.

2 On the Intranets form, select this site's intranet. In the Master Site field, specify the master site
where shared tables will reside.

B Intranets

Intranet

Intranet: |SHAF|ED |
1 DEMO Description: |Shared Intranet |
2

B m. Reporting
Transport: (HTTP
HTTP

Cueus Server | |
[ Private Queus

URL: | |

Direct IDO UAL: | |

Master Site: [ILL | [ILL site

The following must be true in order to add or change a value in this field:
e You must be logged into the site that you want to specify as the master site.

e This site must be defined as being within the selected intranet. Live links must be set up (on
the Sites/Entities form) between this site and the other sites in the intranet.
e No table within the intranet is currently shared.

This master site must be an Infor CloudSuite site, not an entity.

Note: After you define the master site for an intranet on the master site's Intranets form, the master
site name displays, but cannot be changed, on the Intranets form at all other sites. (This assumes you
have set up replication of the Site Admin category from the master site to the other sites in the
intranet, or the sites are in the same application database.)
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Set Up Shared _All Tables

On the Intranet Shared Tables form at the master site, select this site's intranet. A list of the _all tables
that can be shared displays. (Not every _all table is listed; some are not available for sharing.)

Note: If you share _all tables or user tables, all sites in the same database must be on the same
intranet.

Elntranet Shared Tables =] =]
Intranet Intranst: | SHARED
| U Master Site: ILL ILL Sits
2 SHARED
Table Shared Processed i |ﬂl
E aptr=p_all ] |Ml
7 ar_terms_due_all ]
8 arparmg_all ]
9 artran_all ]
10 bank_addr_all ]
1 bank_hdr_all v
12 cfg_attr_all ]
13 cfg_comp_all ]
14 cfg_main_all ]
15 cfg ref all Vv 7
Feplication Category: |Centralized Order Entry lz‘
| FPracess | Frocessing Step:
< [ b

1 For tables that you want to be shared between all sites on the intranet, select Shared.

Another way to choose the shared tables is to select the replication categories that you want to
share. When you select a Replication Category from the drop-down list and click Select by
Category, the system marks _all tables in that category as Shared.

2 When you have selected all the tables you want to share, select Actions>Save.

3 Click Process. This copies information from the tables at the other sites to the master site's table,
deletes the table from the other sites (creating views into the master site tables instead), and
regenerates the replication triggers for the other sites. If you have selected several tables and
have many sites on this intranet, processing may take a while. The Processing Step area displays
the system's progress.

Caution: During processing, the selected tables are removed from all sites on the intranet
except the master site. Unsharing (rebuilding the tables at the using sites) is time-consuming -
so be very sure that you have everything set the way you want it before clicking the Process
button.

During processing, the system validates live link setup between the master site and the using
sites of an intranet. If it finds a problem, an error message displays and nothing is processed; fix
the link and then click Process again.
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The Processed field indicates which tables have been processed - for example, if shared, they
are now resident only in the master site's database. (Once a row on the form is marked as
Processed, subsequent "Process" runs will not reprocess that row.)

After processing all the tables and sites, the system regenerates the replication triggers at the
master site.

Set up Replication to Sites in Other Intranets

If there are other intranets with sites that want to replicate (not share) _all table data to/from sites in
the sharing intranet:

For tables that are shared, set up replication categories/rules between the master site and the
sites on the other intranets. (You probably will also need to set up the same categories/rules
between the specific shared site and the sites on other intranets; see the example below.)

e For tables that are not shared, set up replication categories/rules between any/all of the sites in
the shared intranet and the sites on the other intranets.
Example

In the setup shown below, the following are true:

USA Intranet
Iterm_mst_all
ILL shared
{master site) CAL
e E—
ONT BC
Canada Intranet

If CAL needs visibility into BC's item data, replication rules for a category containing the
item_mst_all table should be set up from BC to ILL.

If BC needs visibility into CAL's item data, replication rules for a category containing the
item_mst_all table should be set up from ILL to BC.

If BC and CAL interact in other ways, for example order entry of an item in BC and shipment of
the item from CAL, you still need Centralized Order Entry replication rules between CAL and BC,
since additional tables and stored procedures in that category are needed to perform these
functions. The item_mst_all table, although it exists in the category, will not be replicated from
CAL to BC.

If ONT needs visibility into CAL's customer data (which is not in a shared table), replication rules
for a category containing the customer_mst_all table should be set up from CAL to ONT.
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Setting Up Non-Transactional Replication

Skip this section if you are not using non-transactional replication (see the definition on page 13).

If you are using non-transactional replication only to interface to another Infor product, refer to the
setup steps in the appropriate product’s implementation guide, instead of the steps below.

Log into each site and entity as "sa" and perform the following steps. See the online help on the
various forms for more information about any step.

Set Up a Replication User

Note: Before completing this step, you will need to install a license. See Chapter 6, “Setting Up
Licensing at Sites and Entities," for instructions.

Create a user account that will be used during replication between the sites/entities. Assign this user
the appropriate permissions to allow replication data to complete the transaction. This protects the
local site from another site inappropriately adding or modifying data on the local site without
permission.

1 Add areplication user called repl_user on the Users form at all sites/entities where non-
transactional replication will be used. Initially, make that user a super user and do not assign any
authorization groups. It does not matter what multi-site group you assign this user to.

Uzer

Uszer ID

Uszer 1D: |rep|_user | ¥ Super User

Uszer Description: |F|ep|ic:ati0n Uszer

T ]
Uszer Pagsword: | ]

Canfirm Pazsward: | |

“whorkstation DomaindD: | |

= UserModuIesl Flow &uthaorizations.. UserAuthorizations..l

Editing Permizzions: |[RELKRES

Groups | Additional Info " Login Information " E-mail Address " Source Control ]

L Primary
Group Mame Group Description G
1 [k r
* r
Fiow Authorizations. .. Group Authorizations. ..

If you have multiple administrators for different sites/entities, you can later decide to revise the
permissions and groups assigned to this replication user, in order to limit the data that certain
sites are allowed to send to other sites. However, until everything is set up and working properly,
leave this user as a super user who can access everything.

Infor CloudSuite Industrial - Multi-Site Implementation Guide | 53



Setting Up Replication at Sites and Entities

2 Click User Modules to specify the license module this user is assigned to. Generally, this should
be SyteLineAutomation.

=] User Madules (Linked) N == E=
byt
User Nams IJzer Mame: |repl_user
1 [n)k | repl_uszer tadule Mame: | Sytelinadutomation| |Z|
*
< 1 3

Set Up System Types

If this site will be replicating data to other applications, or to other versions of Infor CloudSuite
Industrial, use the System Types form to create a system type for each other application/version. This
system type is used when defining the target site for the application in the Sites/Entities form. You
should also define a system type for the Infor CloudSuite application. (The source and target system
types are used in the names of XSL stylesheets that can be used to transform the XML data; see the
System Types help topic for more information.)

E=] System Types [E=5EEE| )
System Type Drescription
1 SL7.00.00 Syteline 7 Yersion 00.00
2 SL7.01.00 Syteline 7 Yersion 01.00
3 SL7.02.00 Syteline 7 Yersion 02.00
4 SL7.03.00 Syteline 7 Yersion 03,00
5 SL7.04.00 Syteline 7 Yersion 04.00
E SL7.05.00 Syteline 7 Yersion 05.00
7 SL8.00.00 Syteline 8%ersion 00,00
*

The list of system types should match at all sites. System Types are replicated by the Site Admin
category rules, so create a minimum list now and add more types later as needed.

If there is not an existing system type called Infor CloudSuite, add it. Some add-on applications may
require this system type.
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Define Intranets

1 Inthe Intranets form, specify all intranets to be used in this multi-site system. The default intranet
is DEMO. You may need additional intranets. During the Planning phase you should have
determined the intranets you need and which sites will use them.

E Intranets == =
Intranet i Intranet: |CANADA

1k | CAMADA Ca Descriptior; |Canada Intranet External

2 DEMO D

3| SHARED o NEEIEEN Reporing

* Transport [HTTP

4

HTTF
Queue Server; |grinchl\PRIVATES

| Private Queue
]
Direct ID0 URAL: |httpd/arinchl /IDORequestService/ConfigS erver. aspx

jun)

L: hitp:Agrinch] AnboundQueue/ nboundlueue, asps

[=]

Master Site:

Tenant 1D:

3

2 Specify connection information used in data requests to and from the other sites:

External: Select this field if the intranet is an external intranet, meaning that it allows
applications other than those based on the Infor CloudSuite (WinStudio) toolset. Replication
done on an external intranet must be non-transactional, and an external intranet cannot have
a master site.

Transport: This field, which is enabled if you selected External, allows you to select either
HTTP or ESB as the transport protocol for exchanging data with external applications.

HTTP POST is used to handle most non-transactional replication. If you select HTTP, you
then define a set of MSMQ instances, MSMQ listeners, and URLs for the intranet.

ESB is used for connecting to messaging middleware through Infor ION.

HTTP: Options in this group are enabled only if you chose HTTP as the Transport method:

Queue Server: Enter the name of the MSMQ server for the intranet. If left blank, this field
defaults to the utility server running this application, and the private queue area. If you
have multiple intranets on different servers, include the utility server machine name in the
path (for example, machinename\PRIVATES).

Private Queue: We recommend that you select this field, since queues in non-
transactional replication are used only by Infor CloudSuite services on the same machine.
Setting up public MSMQ instances requires further ActiveDirectory setup, which is not
required by the Infor CloudSuite services.

URL: This is the web address to which the XML request/response documents will be
posted. When replication occurs between sites on different intranets, XML documents are
routed to this URL for the target site. It may also be used by system integrators for
programmatic access to a site on this intranet.

This URL could be an active server page (ASP) on the external system that receives and
processes the XML from the Infor CloudSuite message queue. The processing done at
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this URL is up to you; for example, an ASP could map the data into the proper format for
the external system, or it could write the XML documents to a location on its server for
later processing.

In many cases, this field provides the address of the default InboundQueue ASP in the
virtual directory that was installed with the web server components.

e Direct IDO URL: This is the web address of the synchronous XML interface to this
Intranet. It is used primarily by WinStudio clients which are configured to connect via the
Internet. It may also be used by system integrators for programmatic access to a site on
this intranet.

You must specify a fully qualified URL. It should be the address of the ConfigServer,
which is deployed on your utility server when you include the web server feature of the
utility server setup. For example, if the machine name is UTILSERVER, then the URL
might look like this:

http://UTILSERVER/IDORequestService/ConfigServer.aspx

Or if you want to use secured http - a good idea if this server will be open to the internet
for http traffic - use this format:

https://UTILSERVER/IDORequestService/ConfigServer.aspx
e Master Site: See “Set Up the Master Site” on page 49.

e Tenant ID: This field is used during integration to other applications through business object
documents (BODs). See the online help for more information.

3 On the General tab, specify the TaskMan Path for each intranet. This is the shared path to the
TaskMan folder on the utility server used by that intranet (usually \machinename\SyteLine). If you
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change the value in this field, restart all TaskMan services that monitor configurations for
application databases connected to this intranet.

O Intranets

(=& e

Intranet”| SHARED

Description: |Shared Intranet

Reporting

| O External

Transport: HTTP

HTTP
Quueue Server:
O Private Queue
URL: |
Direct IDO URL: |
Master Site:
Tenant ID: |
TaskMan

TaskMan Path ™| WGRINCH1\SyteLine

Report Preview URL: | hitp:IGRINCH 1/reporipreview

Polling Interval: | |
Maximum Concurrent Tasks: | |
Max Report Tasks: | |

Send E-mail Notification

Define Linking Between Sites and/or Entities

Use the Sites/Entities form to define entities and sites in your system.

1 In all records for sites and entities that will be participating in non-transactional replication, specify
a system type. On the System Info tab, System Type field, select from the list you created in the
System Types form. The system type you choose should exist at all of your sites and entities.
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If this is a new site/entity record being added for non-transactional replication, specify additional
information about the site or entity, as applicable, on this tab.

O sites (Filter In Place) f=fe]=]

Site: |ILL
Site Name: | ILL Site

Description: | lllincis Site

EYEENILN Site User Map  Link Info

Language:

System Type:
Time Zone: | Central Standard Time
Intranet Name: | SHARED & Intranet Licensing
Database Name: |ILL_App

Forms Database Name:
Message Bus Logical ID:
Tenant ID:
Report Cutput Folder:

Configuration Name:

In the Configuration Name field, specify the name of a configuration that the system will use as
the target configuration when building IDORequest XMLs during replication and AES event
handling. If you leave this field blank, the system expects that a configuration exists with exactly
the same name as the site name, and it uses that as the target configuration.

The Reports To (entity) field on this form is display-only. Reporting hierarchies are set up later
through the Change Reports to Entity utility (page 71).

2 On the Site User Map tab, specify the Infor CloudSuite user name under which the local site (the
one you are currently logged into) communicates with the target site (the site whose record is
currently displayed). From Site is the local site. User Name is the local user that the local site
specifies when using the IDO connection to perform the requested transaction on the target site.
The user name and the password for that user must be the same on both the local and target
sites. For now, specify the user name repl_user (set up on page 53) for all sites.
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For site/entity records where the current site/entity will perform non-transactional replication
with the local site, the Site User Map tab looks like this:

Infor ERP 5L {JLL) - Sites/Entities

Form  Actions

Edit  Wiew

Window  Help

BEHIRMAXIEEHAU K4 »rH

SHERE YTk

= EEs

E Sites/Entities
Site

1 CAL

2 CRP

3 ILL

4 Lsa

> -
*

4 3

Site: |BC
Site Mame: |BC Site

Diescription: |British Columbia Site

Spstem Info | Site Uger Map  Link Info
From Site Uszer Mame
1 ILL repl_user
*

BC (the current record) is the "To" site and ILL (the local site) is the "From" site.

For site/entity records where the current site/entity will perform transactional replication with
the local site, the Site User Map tab looks like this:

Infor ERP 5L {JLL) - Sites/Entities

Form  Actions

Wiew  Window  Help

BEHOR MA@ Y

SHERE YTk

= EEs

E Sites/Entities
Site

o

2 CRP

3 ILL

4 Lsa

5 EC

*

4 3

Site: |CAL
Site Mame: |CAL Site

Diescription: | Califormia Site

Spstem Info | Site Uzer Map  Link Info

From Site Uszer Mame

1)k

The tab is blank because no Site User information is required from ILL to CAL.

For the local site’s site/entity record when the local site is also used as the replication
"bootstrap" configuration for the utility server (see page 35), the Site User Map tab looks like
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this:

Infor ERP 5L {JLL) - Sites/Entities
Form  Actions  Edit  Wiew  Window  Help

SEHORIMAXI@A@QUIN 4 b H SR NS
E Sites/Entities =] =]
o Site:ILL
1 EC Site Mame: |ILL Site
2 CAL Diescription: |linois Site
3 CRP
4y ILL System Info | Site Uzer Map  Link Info
5 UsSa
& ONT From Site Uszer Mame
7 CaN
* 1 CaL tepl_user
2 CRF repl_user
3 LS4, repl_user
*
4 3

The Site User Map lists all the other sites on the utility server where replication will be
"bootstrapped"” from ILL (the local site).

e For the local site’s site/entity record when the local site is not used as the "bootstrap"
configuration, the Site User Map tab looks like this:

Infor ERP 5L {CAL)Y - Sites/Entities
Form  Actions  Edit  Wiew  Window  Help

BEEHIRIOX EEXA KA »H

N

BIF 8Bty IE

= EEs

E Sites/Entities
o 9 Site: |CAL
1 EC EQY Site Mame: |CAL Site
el 3 CaAL A Diescription: | Califormia Site
3 CaN Ly
4 CRP CH Sustem Info | Site User Map  Link Info
5 ILL 1LY
e ONT o From Site Uszer Mame
7 UsSa g
* 1)k
*
4 3

No sites are listed in the Site User Map tab (because the CAL site does not replicate data to

itself).

Update Views

Use the View Management form to regenerate table views.
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1 At one site/entity in each application database, open the View Management form.

View Management

This form regenerates views for pertinent tables in the specified range.

Starting Ending

Table: | M || M

2 Leave the range fields blank and click Generate.

Regenerate Triggers

Use the Trigger Management form to regenerate table triggers.

1 At one site/entity in each application database, open the Trigger Management form.

Trigger Management

This form regenerates Insert and Update triggers for the pertinent tables in the specified range.

Starting Ending
Table: [| v] | v

2 Leave the range fields blank and click Generate.
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Set Up Replication Categories and Rules

1 Familiarize yourself with the default categories listed in the Replication Categories form. Be
aware of what categories are available and what each one handles. See the Multi-Site Planning
Guide for additional information about the categories.

(m| Replication Categories o |[[E [
Category Category: AP
1 . Description: | Accounts Payable
2
3
4 Table Or Function Object Type Filter
5 1 »
8 2
7 3
g8 4
a 5
10 5
11 7
12 5

Use the default categories "as is" for now. You may want to add new categories later when your
system is up and running.

Note: Adding new categories and rules requires significant knowledge of the database and
business rules. When multiple tables are related, the order of replication can be critical.
Improperly creating and executing replication categories and rules can result in catastrophic loss
of data. Ensure that all such development and testing is performed in a controlled pilot
environment prior to implementation. We strongly suggest that you contact Infor Consulting
Services for assistance.

2 Inthe Replication Rules form at each site/entity, set up non-transactional rules for the Site Admin
category between this site and all other sites and entities where non-transactional replication will
take place.

Add more non-transactional rules from this site/entity to other sites/entities, as appropriate.

E Replication Rules El@
g_ourc:e Tgrget Categary N
ite Site Source Site: |ILL
1 ILL BC Site Admin Target Site: |BC
2r ILL BC Centralized Ord Categary: Centralized Order Entry
3 ILL BC Inventary/Tran Deescription: |Mon-Tranzactional
4 ILL CaN Site Admin
K Interval Type: |Immediate lz‘
Interyal: 0
Start Interval &t
Dizable Replication
Update All Columnz
4 m 3

e For the Interval Type, select anything other than Transactional, and specify the appropriate
interval and start date/time.

e You should have created a ReplicationRules spreadsheet as part of your Planning phase. You
can save time by importing the appropriate rules for each site from the spreadsheet into the
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grid on the form at that site/entity. See Appendix C, “Data Load To/From Spreadsheets," for

more information.

e If a rule refers to a site/entity that is not set up with matching information in the Sites/Entities
form, the system will give a validation error when you try to save it.

3 At each site/entity, go to the Replication Management form and click Regenerate Replication

Triggers.

E Replication hManagement

= EEs

Uze these replication-related forms to zet
up replication rules

Intranets

Intranet Shared Tables
Sites/E ntitie:s

Eeplication Cateqories
Eeplication Rules

Manual Replication Utility
Eeplication Erors

Find Replication Setup | ssue

Changes to replication rules are not in
effect until you regenerate the replication
triggers uzing the pushbutton below

Fegenerate Replication Triggers

Fiegenerate views when intranet table
sharing iz in place, and table definitions at
the Master Site have changed

M aster Site:

Fiegenerate iews to Master Site

Note: Finish this step for all sites and entities before continuing with the next step.

If you have multiple sites per database, you can set up rules and regenerate triggers for all sites in the

database from one site.

Populate Parameter _All Records at Other Sites

In the Update _All Tables form at each site and entity, repopulate certain _all tables.

[E=] Update _ All Tables ===
Select | Table Mame Message ;

1 [ ana_ledger_all

2 [ ana_pertot_all

3 [ apdraftt_all

4 apparms_all

5 aps_parm_all

E [ aptr_all

7 [ aptrsp_all

g [ ar_terms_due_all

9 arparms_all

10 [ artrar_all

11 [ attribute_group_all

12 [ attribute_value_all

1n = oo aa k%
1 m b

Replication Categon: |Iritialize _Al Parameters [=] [] Disable Replication Site: =
[T Inciude &1 Sites in Intranet
| Select Al |  TwncateTables | Delste Site Records
| Deselect &l | W Delete Mon Site Records

Note: You must perform this step if the Sites/Entities form lists at least one site that is not in the same
application database, even if you are not currently replicating any data to/from that site. The form lists
only those tables that are shareable. If all of the internal sites (that is, sites on an intranet that is not
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set to "External") which are listed on the Sites/Entities form reside in the same application database,
this should be an empty list.

In an initialized database, the parameters tables already have one record defined for the local site.
Because the record already exists, it will not be created at other sites through normal replication.

Repopulating the tables ensures that a parameter record for the local site exists at other sites where it
is needed.

1
2

Click Deselect All to deselect all tables in the form.

Select the Initialize _All Parameters replication category and click Select By Category to select
the parameters tables.

Make sure nothing else is selected (including Disable Replication or a Site name).

Click Repopulate Tables. This repopulates each selected parameters _all table at the local site
and creates/repopulates the local site record at any other sites/entities to which the local site is
replicating a category containing the parameter table.

Note: At this point, back up all databases to save your replication setup in case problems occur later
in the implementation.
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and Entities

You should have requested and received the proper licenses for each of your sites and entities from
your Infor representative. Use the Licensing spreadsheet from your Planning phase to help with this.

Intranet Licensing

If you do not plan to use intranet licensing, skip to “Site/Entity Licensing” on page 66.

Note: Intranet licensing is required if you plan to use the Intranet Shared User Tables feature.

Prerequisites

If you plan to use the Intranet Licensing feature, the following must be true. Instructions for all of these
prerequisites are found in Chapter 5, “Setting Up Replication at Sites and Entities:"

You must have set up an intranet with a master site.

All sites that will use the intranet licensing must be set up (in their Sites/Entities form) to use that
intranet.

All sites on that intranet must be replicating the Site Admin category, in order to recognize the
master site.

All sites that will use the intranet licensing must specify an application database name in their
Sites/Entities form.

Turn on Intranet Licensing at the Master Site

1

At the master site only, log in and follow the steps under “Site/Entity Licensing” on page 66 to
apply a license.
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2

In the master site’s Sites/Entities form, select the Intranet Licensing check box on the local site
record and save the record.

B9 Sites/Entities E
Stte Site: [ILL
1 Cal Site Mame: |ILL Site
2 CaM Diezcription: |linois
3 CRP
4 [m)» |ILL Spstem Info | Site User Map | Link Info
5 ONT
g LSk Type: |Site
* Language: v
Last Consolidated:
Feports To:
System Type: o
Time Zone: [Eastemn Standard Time w
Intranet Mame: | SHARED
[atabaze Mame: |ILL_App
Faorms Database Mame:

Turn on Intranet Licensing at Other Sites

1
2

Make sure all other users are logged out of the sites.

Log into any other sites and entities where you want to use the master site’s licensing. On the
Sites/Entities form at each site, select the local site record and select Intranet Licensing. Save
the record.

Log out of all the sites, including the master site, and then log back in. This picks up the changes
to certain licensing records, which are now stored only on the master site. The licensing forms are
now disabled in the non-master sites on the intranet.

Site/Entity Licensing

Note: Licensing is applied to an application database. If you have multiple sites in one application
database, you apply licensing in one site in the database, and then use the Optional Modules form in
each of the sites in the database to enable the features for licensed modules in that site.

Initial Steps

Perform the following steps at each site and entity. Or, if you are using intranet licensing, perform
these steps only at the master site.

1

Go to the License Management form, where you will apply the appropriate licenses.
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2 Select the Apply License tab.

Licenzed Modules HMulti-Session Users Apply Licenze

License Document:

Apply Licenze
Clear License Field
Browse...

3 Paste your license document into the License Document field. You can cut and paste the
information from the license document into this field, or you can click Browse and select the
document from your drive. The document is encrypted and every character counts, so if you copy
and paste, make sure to copy the entire contents of the document.

4 Click Apply License. Any previous licensing that you had for this site is deleted and replaced with
the licensing defined in the new license document.

The Licensed Modules tab should look similar to the following example after you apply your
license; however, you may have different or additional modules licensed.

Licenzed Modules HMulti-Session Users Apply Licenze
Module Mame bic:ensed Beqin Date Expiration Date Status T
sers
1 SyteLinedutomation g 10/09/2007 12/31/2993 alid
2 SyteLineDC 1 10/09/2007 12/31/2993 W alid £
3 SyteLineDC_MS 1 10/09/2007 12/31/2993 alid
4 SyteLineDev 1 10/09/2007 12/31/2993 alid
5 SyteLineTrans 1 10/09/2007 12/31/2993 alid il

The Multi-Session Users tab lists any multi-session users defined by your license; generally this
just displays the SL_Internal user. For information about this user and about how concurrent or
named user licensing works, see the Infor CloudSuite Industrial Licensing document.
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Additional Steps

1 At each site, use the Optional Modules form to enable the licensed modules for that site.

m| Optional Modules [E
Optional Module Name Enabled g”eit;? Licensed Module Description =
1» :
2 [m]
3 [m]
4 1
5 [m]
& [m]
7 [m]
g o
g

2 If there were active WinStudio sessions when you applied the license, perform the following steps
on the utility server. If there were not any active sessions, you can skip these steps.

a Open the Configuration Manager utility (Start>All Programs>Infor>Tools>Configuration
Manager).

b Select the Utilities tab.

I Configuration Manager

Configurations | Applications | ‘Web Servers | Configuration Groups | Utilities

() Al Configurations
() Configuration

() Configuation Group

[]100 Runtime on local machine [ Digcard IDO Cache ]

l Publizh Form Change ]

I| Path: C:\Documentz and Settings'all Usershdpplication DataWongoose

¢ Discard the Runtime Service Cache for all configurations that reference the application
database to which the new license has just been applied. To do this, select All
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Configurations and IDO Runtime on local machine, and then click Discard IDO Cache.
See the Configuration Manager online help for more information about the options on this tab.
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Chapter 7: Setting Up Accounts and
Financial Reporting
Hierarchies

Set Up the Financial Reporting Hierarchy

Note: Perform this step only if you are setting up a hierarchy of sites and entities.

1 At each site and lower-level entity, run the Change Reports To Entity utility and specify the entity
to which this site/entity reports.

E Change Reports To Entity El@

Thiz utility allows a Conzalidation Feparting Structure b be set up and modified. Histonc data will not chanae. Before
tunning this utility, the ending balances for every account at the Site must be calculated and conzolidated up the old
Financial Entity higrarchy by running the Ledger Conzolidation activity at each site. wWhen run, thiz utility changes the
reporte-to Financial Entity. The Ledger Conzolidation Uil must be run again to complete the change process. This
conzaolidates the beginning balances for each account up the new Financial Entity Higrarchy.

I thiz utility iz run at a Site, the reports-to change iz limited ta Financial Entities which have the zame baze curmency and
Chart of dccountz. The ending balances for every account at the Site will be calculated and congolidated up the old
Financial Entity higrarchy. The utility then changes the reparts-to Financial Entity. To complete the change process, the
Ledger Congolidation Lkl must be run o congolidate the beginning balances for each account up the new Financial Entity
Hierarchy.

If this wtility iz being mn at a Financial Entity at any level, the cloging balances for each account at every site beneath the
Financial Entity will be calculated and conzolidated all the way up the hierarchy.  The utility then changes the reporta-to for
the Financial Entity. To complete the change process, all of the reports-to account mappings for the Financial Entity's Chart
of Account: must be carected to map to the Chart of Accounts of the new reports-ta Financial Entity and the Ledger
Conzolidation Lkl must be run at each affected Site to congolidate the beginning balances in the new structure,

Feports To: [1EE |Z| M airtain Chart b apping

Cutoff Date: |01/01/1753 [+ ] [7] Post Balances

Currenicy Translation Date: | 1041042000 |E|

Use your flowchart from the Multi-Site Planning Guide when setting up this hierarchy.
If there is only one entity in the hierarchy, you do not need to run this utility at the entity.
You do not need to run this utility at the highest-level entity in the hierarchy.

For sites and entities that will communicate financial information through replication,
replication rules must be set up and running before you run the Change Reports To Entity
utility. The Change Reports To data is replicated in the G/L or Ledger Consolidation
categories, and the Reports To field is replicated in the Site Admin category.
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e Before running this utility, make sure base currency and the chart of accounts match at the
current site and the entity it will report to. (If this is a new site/entity, the chart of accounts will

not yet exist.)

e The site will report to the new entity on the day after the Cutoff Date. This date cannot be
earlier than the creation date of the site database.

e During consolidation, the system will look for a currency exchange rate with the Currency
Translation Date you specify here, and then uses that rate for the consolidation.

e See the online help for additional information about this utility.

After you run this utility, verify whether the reporting hierarchy is set up correctly. Go to the Sites/

Entities form at the highest-level entity and check whether the Reports To field displays as

expected for each site and entity.

Set Up Accounts

1 In the Chart of Accounts form at the corporate (highest-level) entity, add all of your accounts. (If
your system does not include any entities, set up the Chart of Accounts at each site.)

O Chart of Accounts EI@
fecount Account: 10000 Cash
Account Type: Asset Effective Date: O Control Account
2 E Account Class: | Current Assets Obsolete Date: Allocations
3 Exchange Rate Type
4r Unit Code 1| No Access Unit Code 37| No Access
5 Unit Code 2| Accessible Unit Code 4° | Accessible
[
7 Reports To Acct:
] Currency Translation Method: Mone
9
10 Unit Code2 [UiigeL L0 Dimensions
1 Unit Code 4 Description CopiniiCotieRts
12
»

13

2
14
15 3

4
16

5
17
18 }

»

Note: You might be able to input your accounts from a spreadsheet that is set up to match the
form’s grid view. See Appendix C, “Data Load To/From Spreadsheets," for more information.

You cannot add the unit code information in the same spreadsheet as the account information,

since they are different collections.
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a

If you have entities and are consolidating accounts, be sure to add an account with an
Account Type of Owner’s Equity to be used as your Cumulative Translation Adjustment (CTA)
account.

Make sure that Inter-entity account numbers used for material transfers at sites that perform
transfers with profit are different from your normal sales account numbers. This helps you
know what to eliminate (as profit) when you consolidate to the entity level.

By default all unit codes are accessible for all accounts. If you want certain unit codes to be
required or not accessible for certain accounts, specify that in the Chart of Accounts at the
corporate entity. When you save the account record, a message similar to the following pops
up for each unit code you marked as not accessible:

':e] Any Unit Code? values for this Account will be deleted

Ok l | Cancel

Click OK.

Do not set up information on the Unit Code 1-4 tabs yet. This information may be different for
each account at each site/entity and will be set up later, after unit codes are defined.

2 If you have multiple levels of entities, do the following. If you have only one entity, or no entities,
skip this step.

a

At the corporate entity, use Multi-Site Chart Copy to copy the chart of accounts from the
corporate entity to any mid-level entities that use the same (or similar) chart of accounts.

[E=] Multi-Site Chart Copy ===
To Site: |USA lz‘ Starting Account: | 10000 lz‘
Ending Account: o100 lz‘
Copy Reports To Acct Ovenwrite Existing Records
Process

You may see the message Account will be created. If so, click OK. When processing is
complete, a message indicates the number of accounts that were processed.

If an error message displays while you are performing this step, see the information in the
“Troubleshooting" chapter on page 113.

If a different chart of accounts is required at the mid-level entity, then the chart of accounts
can be created at the mid-level entity, setting up Reports To accounts to the corporate entity.
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b In mid-level entities, use the Chart of Accounts form to map each account to a "Reports To"
account in the entity being reported to. You must do this in order for the Ledger Consolidation
utility to work properly.

O Chart of Accounts EI@
fecount Account: 10000 Cash
Account Type: Asset Effective Date: O Control Account
2 E Account Class: | Current Assets Obsolete Date: Allocations
Exchange Rate Type
4r Unit Code 1| No Access Unit Code 37| No Access
5 Unit Code 2| Accessible Unit Code 4° | Accessible
[
7 Reports To Acct: 10000 Cash
] Currency Translation Method: Mone
9
10 Unit Code2 [UiigeL L0 Dimensions
1 Unit Code 4 Description CopiniiCotieRts
12
»

13

2
14
15 3

4
16

5
17

e The existing accounts at the higher entity are listed in the Reports To Acct field drop-
down. You can map to the same account or to a different account.

e If the mid-level entity’s base currency is different from the higher entity’s base currency,
you can specify the currency translation method to use when consolidating the account
information. To comply with FASB52 or GAAP standards, you must set the currency
translation method to Average for revenue and expense accounts and to End for asset
and liability accounts.

3 Verify that the Chart of Accounts was automatically populated in each of the sites reporting to
each entity. This is handled by ChartAcctRemoteSp in the Ledger Consolidation or G/L replication
category.

Note: Users cannot change the chart at the child sites, but they can update descriptions, delete
accounts that do not apply to the local database, update obsolete/effective dates, and set up the
Unit Code 1-4 tabs for the accounts.
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4 At each site and entity, set up the unit codes that can be selected for each account.

a Define unit codes on the Unit Code 1-4 forms. See the help topic on "Account Unit Code (1-
4)" for information about how unit codes are used.

B Unit Codes (4)

EEI:_Ie Description

1» Us Dollar
Australian Dollar
Japanesa YEM

Euro

moRE W M

Germman Deutsche Mark

Note: You might be able to input your unit codes from a spreadsheet that is set up to match the
form’s grid view. See Appendix C, “Data Load To/From Spreadsheets," for more information.

b Run the Copy Unit Codes to Accounts form to copy a range of unit codes to a range of
accounts. This fills in the information for each account on the Chart of Accounts form’s Unit
Codes tabs at the site or entity. If an account is set up so that one or more of the unit codes is
inaccessible, the utility does not populate those unit codes.

ECopy Unit Codes To Accounts =] =]
Thiz Ltility will copy all Unit Codes from within the entered ranges into the Chart/Unit Code
tables for the entered range of Accounts,

Starting Ending
Account: 10000 [=] [40100 [=]
CopyUnit Codel 100 [+] 00 [+]
CopyUnitCode2 100 [+] 00 [+]
[ Copy Unit Coded
Process

Note: When you define unit codes for an account at any site/entity, we recommend that you also
define the unit codes for the account at the entities it reports to. Otherwise, after you consolidate
the ledger transactions, the unit code is inserted into the unit code table at the entity but the
description is not populated. Also, the unit code is not populated for the chart of accounts in the
entity.
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c For greater efficiency, you may choose to copy all unit codes to all accounts in step b, and
then go to the Chart of Accounts form to delete individual unit codes from certain accounts, as

appropriate.

O chart of Accounts

ool Account: 10000 Cash
Account Type: Asset Effective Date: O Control Account

2 Account Class: | Current Assets Obsolete Date: Allocations
2 Exchange Rate Type
4r Unit Code 17| No Access Unit Code 37| No Access
5 Unit Code 2| Accessible Unit Code 47| Accessible
G
7 Reports To Acct:
8 Currency Translation Method: None
9
10 '!l" I!:I: g Unit Coded Dimensions
1 Unit Code 2 Description CopUniEaers
12
13
14 »® 2y 0002 Finished Goods MTN Bike A

. 3 [

5 At all entities, in the Accounting Periods form, add accounting periods. (If your system does not

include any entities, set up Accounting Periods at each site.)

E Accounting Periods El@
e Fiscal Year:| 2010 [7] Closed CurentPeriod: |2 =] [02/01/2m0 | [n2/28/2010
12 EEEE l Control Humber Sequences
ar 2mo Period Mumber Start Drate End Date
e 1 oo/2010 [+] [ovmzoo [+
z 022010 [+] |ozrzaszoi0 [+
% oavmseon [« |oastvzn0 [+
4 040172010 [+] [oasz0v2010 [+]
5 050172010 [+] [o5/31/2010 [+] *) Manthly
£ |06/01/2010 [+] [0Bs30v2010 [+] ) Quartely
7 ozmszonn [« |o7sstszonn [+
& [oa/menn [+] |oaseon [+ ieneratelieriod
g [oa/mszonn [« |osssovzonn [+
10 1ot200 [«] hovmsemo [+
1120 [¢] vavzmo [+
12 1zmi200 [«] hzmsemo [+
13 [=] [=]
4 3

Note: Accounting periods set at an entity will automatically populate each child site’'s accounting
periods (through Ledger Consolidation or G/L replication). If you have entities, you cannot update
accounting periods at the site level. You will maintain the Current Period at all entities and sites.

Accounting periods must be set up manually at mid-level entities. You might want to export the
accounting period grid at the corporate entity to a spreadsheet, to use when populating mid-level
entities. See Appendix C, “Data Load To/From Spreadsheets," for more information.

6 Make sure the Accounting Periods were replicated to the appropriate sites.
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7 If you have multiple levels of entities, do this: at mid-level entities, run the Verify Reports To
Account Report, turning off the Invalid Accounts Only flag so that all accounts are listed. Keep
this printout for future reference. (If you have only one entity, or no entities, skip this step.)

E‘u‘erify Reports To Accounts Report [ ][ =] =]
Irvald Accounts Onlp Dizplay Report Header
Starting Ending I}
Account: 10000 [~] 00 [+]
Freview | | Frint |

Multiple Financial Sets of Books

If you need more than one set of financial books, you can set up that feature at any time, for a specific
site. The first step is to select Multiple Financial Sets of Books on the General Parameters form (page
82). For more information, see the help topic on Setting up Multiple Financial Sets of Books.

Set Up Financial Statements

During the Planning phase, you should have determined where you want to run financial statements
(at which level of entity, or at each site). Perform this step at those sites or entities.

Use the Financial Statement Definition form, along with the Financial Statement Definition Columns
and Financial Statement Line Definition forms, to specify the content and format of a statement.

Once you have defined a statement, you can print it by specifying the Report ID in the Financial
Statement Output form.

Reports you might design using the Financial Statement Definition form include:

Balance Sheet

Income Statement (Profit and Loss)
Statement of Cash Flow
Components of Working Capital
Changes in Financial Position

See the online help topic titled "Financial Statement Setup" for the steps to follow.

Infor CloudSuite Industrial - Multi-Site Implementation Guide | 77



Setting Up Accounts and Financial Reporting Hierarchies

You can also use Infor CloudSuite’s Excel-based toolset for financial reporting to connect to any site
or entity database and extract data, using formulas, into a spreadsheet. The spreadsheet can then be
used for financial reporting. The toolset does not support multi-currency consolidations. For more
information, see the Infor CloudSuite Industrial Microsoft Office Integration User Guide.
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Chapter 8: Setting Up Parameters and
Codes

The following parameters and codes must be set up next, because they are used when creating the
records in later steps. Any special implications for multi-site setup are explained below. Read the
online help for each form to get additional details.

Set Up Site Groups

At all sites and entities, set up Site Groups for the various sites that will be doing centralized order
entry, transfer orders, or financial reporting. Since Site Groups are replicated (in the Site Admin
category), they can be set in one site or entity and be replicated to other linked sites/entities.

E Site Groups =] =]
Ed[uolﬂ-psite Site Site Mame
1 Default Cal CAL Site
2 Drefault CRF CRF Entity
3 Default ILL ILL Site
4 Drefault LS4, LS4, Entity L\\’
5 FIN CRP CRP Entity
g FIN UsSa US4 Entity
*

One site group was set up with the Infor CloudSuite Industrial Configuration Wizard on the database
server, but the sites in the group might need tweaking, or you might want to define additional groups
for additional purposes.
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Set Up Countries and States

1 For each site and entity, go to the Countries form and add records for the countries listed on the
Currency spreadsheet you created during the Planning phase, plus any countries that will be
needed for the site/entity addresses on the General Parameters form (see page 82). You can
also add other countries needed for customers and vendors.

E8 Countries = E
Country Eoﬂdeﬁountry 150 Country Egde EEEEEU Export Document R equired
1 AMDORRL A0 ANDORRA O
2r AMGOLA A0 ANGOLA O
3 Australia Al AUSTRALIA Al |al O
4 Astria AT AUSTRIA AT AT O
[} Bahrain EH BaHRAIN Ll
E Belgium EE BELGILIM BE |EE O
i BOSHIA AND HERZEGOWVINA B BOSHIA AND HERZEGOVINA O
g BErazil ER BRAZIL BR |BR O
9 Bulgaria BG BULGARIA BG |BG O
10 Canada a CANADA ca |ca O
1 China CH CHIMNA CN |CH O
12 Cyprus oY CYPRUS oro|Cr O
13 Czech Fepublic [nea CZECH REPUELIC cz cz O
14 Estonia EE ESTOMIA EE |EE O

e Country codes are replicated to other sites/entities if A/P, Shared Currency, or Centralized
Order Entry categories are being replicated. So if you are maintaining currency information at
one site or entity and replicating it to the others, you should enter your initial country list at the
site/entity where you will maintain currency information.

e |If the Activate EU VAT Reporting field is not selected on the General Parameters form, the
EU and SSD EU fields are disabled here and do not allow data entry.

e When integrating Infor CloudSuite with other Infor BOD-enabled products, only ISO country
codes can be passed in the BODs. If you are creating a new system, we recommend that you
use the ISO country codes when defining new countries. If you already have existing non-1ISO
country codes, you can map them to ISO codes using this form.

2 For each site and entity, go to the Prov/States form and create province and state records to be
used when you enter the company address in the General Parameters form for each site and
entity database. You can also add other provinces and states needed for customers and vendors.

B Prov/States [F=3E=R 5
Prov/State Description Country 1;:9!; Postal lf;lgjyln mum 1J!;|gq agnetic Er'ﬁ'.eq:.:.d
4 Australian Capital Territory Australia 0.00 ()]
5 Alaska usa 0.00 [m]
[ Alabama USA 600.00 ]
7 Arkansas usa 0.00 [m]
g Arizona usa 0.00 [m]
9 Brandenburg Germany 0.00 ] 12 -

Province and state codes are replicated in the Multi-Site CRM category.
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Set Up Currency

1 For each site and entity, set up Multi-Currency Parameters. These are used as the default
account values when you add new currency codes.

E Multi-Currency Pararmeters =] =]

Domestic Currency: \CHD
Euro Currency: lz‘

Unrealized Bealized/Other

Unrealized Gain: 11700
Unrealized G ain

Unrealized Loss: | 20070
Unrealized Loss

/R Unrealized Offset: 11710
A/R Unrealized Offset
/P Unrealized Offzet: | 20080
A/P Unrealized Offset

EEEE )R]
ELEEE]

/P Uniealized Offset: |

e Domestic currency was determined when the database was created and cannot be changed.

e You can return to this form later to specify the Euro currency, if necessary. It is not defined
until the next step.

e This information is not replicated and must be entered at each site and entity.

2 For each site and entity, set up Currency Codes information.

O currency Codes [=j[&= ==

Currency: AED UAE Dirham
IS0 Currency: | AED UAE Dirham

Currency Symbol:  |AED

(e eIl Unrealized  Realized/Other Excise Rates

Amount Format: |-==»»>>>==009 O Active For Customer Portal
Amount Total Format: |-===>=>=>>>>>0.00

Cost/Price Format: |->=>=>=>0.00999

O Part of Euro

Euro Exchange Rate: 0.000

Note: When you use this form, a message displays to indicate that you must log out of Infor
CloudSuite after updating this information. However, you actually can continue through setting up
the General Parameters (page 82) before logging out and restarting Infor CloudSuite.

e Some currency information is replicated to other sites/entities if categories containing the
currency_mst, currency_mst_all, currate_mst or currate_mst_all tables are being replicated.
So if you are maintaining currency information at one site or entity and replicating it to the
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others, you should enter your initial currency codes at the site/entity where you will maintain
currency information.

e When you integrate Infor CloudSuite with other Infor BOD-enabled products, only ISO
currency codes can be passed in the BODs. If you are creating a new system, we recommend
that you use the ISO currency codes when defining new currencies. If you already have
existing non-ISO currency codes, you can map them to ISO codes using this form.

e The currency codes, formats and rates are replicated with any of the above categories, but
the related account information is not replicated.

e Use the Currency spreadsheet you created during the Planning phase. An initial record
already exists for the site’s domestic currency, so do not include the domestic currency in the
import from the spreadsheet. Edit that record manually in the form.

3 If you enter additional currencies beyond the domestic currency, then when you save the record
the system asks if you want to run the Currency Rates form to create rates for the new currency
codes. Click No. (Clicking Yes opens the Currency Rates form linked to the last new currency
you added. It is faster to set multiple rates using an unlinked version of the form, as in the step
below.)

4 For each site and entity, on the Currency Rates form, specify the appropriate rates between the
domestic currency and any other currencies. Rates can be modified later.

E Currency Rates (Linked) EI@

Comestic: o E
Currency UITency To Curency: |USD|

1[nk |USD CHD 10, From Currency: |CHD
* Effective Date: | 10/15/2007 01:47:57 PM lz‘

-From Currency to One Unit of Ta Curency
Buying Exchange Fate: 1100 CHD /A USD
Selling Exchange Fate: 0900 CHD /USD

Lzer Initials:

4 [ 3

Set General Parameters

For each site and entity, go to the General Parameters form.

Note: Some general parameter information for each site can be replicated to other sites and stored in
the parms_mst_all table. None of that information from other sites is displayed on this form, however.
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1 Onthe Address tab, specify the company address to be used for the entity or site. The name and
address specified on this tab is displayed on invoices, checks, credit/debit memos, payroll and tax

documents, and so on.

O General Parameters

LGl General

(=&

Site: OH Chio

.| Progressive Cycles

*| Address-2
- :Adcress—S
4]: | Address-4

ty? | Columbus

ZIP: 43231
Country: | United States

Phone: |614-895-0738

URL: | www.infor.com

E-mail: | perry.coate@infor.com

-| 5400 Cleveland Avenue

Prov/St: |OH

2 On the General tab, specify at least the following options. Many of the parameters here turn on/
off other features and fields in Infor CloudSuite. Use the online help to select the options you

need.

O General Parameters

Address ReESIEE

(=& e

Multi-Site Group™| OH
Transfer/Project BOL Prefix:
Allowable Days Forward:
Allowable Days Backward:
EU Wt. Conv. Factor:
Current Fiscal Year: | 2015

Message Num Prefix |SL_

1.000000

] Capitalize State Abbreviations

®

) Print Company Name on Forms

i
=play Report Headers

) Post to Journal

p

) D
p

] Post and Print Simultaneously

& Activate EU Reporting

(O Use Analytical Ledger

(0 Use External General Ledger

) Hide Parent Grid Columns

(O Secure Control Accounts

¥ Set Default Ending Value to Starting Value

(O Multiple Financial Sets of Books

(0 Use Alternate Address Report Formatting

®

] Enable Cancellation Posting

e Update the Current Fiscal Year.

e Specify a multi-site group. This group becomes the default value that is used in the Site

Group field on reports and utilities.

e Optionally, specify a transfer/project BOL prefix. Site-specific prefixes can make it easier to
determine which site originated an advance ship notice.

e Select Set Default Ending Value to Starting Value. Then, in any form where users can
specify a range of values, the value they specify in the Starting field is automatically set as the
default value in the Ending field. This prevents users from accidentally running extremely long

reports that list all possible values.
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e If you want to use multiple financial sets of books, select that option. For more information
about this feature, see the online help.

e For entities, specify the CTA Account. This account is used to store the currency translation
differences that might occur during the consolidation of accounts to this corporate entity.
Note: The CTA account can only be set up after the Reports To Entity hierarchy is set up (see
page 71).

3 Log out of the site/entity and then log back in. Changes to the currency codes and the general
parameters require this.

Set Up Bank Codes

At each site, you must set up at least one bank code. If A/P checks will be written in multiple
currencies, you must set up a bank code representing each currency. Use the Bank Reconciliations
form to do this.

O Bank Recanciliations (o= =]

Bank Code™| BBC

Bank Mame: | Bank of Canada
Bank Account | 123123
Cash Account: | 10000

Description: Cash

C.rren-:'-;:* CAD Canadian Dollar Domestic Balance: 0.00000
Bank Transit Number: Bank Balance: 0.00
BIC: Balance: 0.00
IBAN:

Balance Compute Bank Addresses

*Type *Transaction Date Transaction Voided Ref Type Ref Num L

Number

W 1) Other 8192015 100 [m] BAL
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Set System Parameters

1 At all sites that will transfer items or material to other sites, use the Inter-Site Parameters form to
establish the relationship between sites and to identify the inter-company account numbers to use
during transactions. See the help topic "Moving Items or Materials Between Sites."

E Inter-Site Pararneters =] =]
From Site From Site: [ILL ILL Site
s ILL Reparts Ta: \USA
2 ILL To Site: |CAL CAL Site
_* Feports To: \USA

General  Ship From  Beceive To Payment  Ship From COS

Posting Method: |Intra-Entity lz‘

Transit Time: a0
FOE Site: ILL [=]
ILL Site
Frice Code:
Exchange Fate: 1.000 Calculate Exchange Rate
Intra-Entity Clear Ship: lz‘
Intra-Entity Clear Receive: lz‘

4 3

e This form must be completed before any multi-site activities take place. Specify the
information in one site, and then most of the information in the records is added automatically
at other sites where Site Admin is being replicated.

e On the General Tab, define the following:

e Posting Method: Although your choice here is "intra-entity" or "inter-entity," this setting
really has little to do with entities. It determines how accounting transactions between the
sites are handled. Think of "intra-entity" as "at cost" and "inter-entity" as "with revenue."

e Price Code: This code can be selected here but it is not defined yet. Return to this form
and select a price code later. The price code is only used when the Posting Method is
inter-entity.

e Exchange Rate: The exchange rate is only used when the To Site and the From Site
have different base currencies.

e The accounts listed at the bottom of this tab are used only when the Posting Method is
intra-entity.

e The information on the Ship From, Ship From COS, and Receive To tabs is used only when
the Posting Method is inter-entity.

e The information on the Payment Tab is used only for A/P and A/R payments.
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2

At the sites, set up Accounts Receivable Parameters.

O Accounts Receivable Parameters (o= =]

KRN Aging Report  Accounts  Accounts In Process Misc Accounts Misc Accounts (2) Report Templates _ Electronic Bar »

Finance Charges Number of Lines

AR Invoice Credit Debit Memo Template™| Simple

Customer Prefix [C Surcharge Factor”| 1.0000
Multi-Site Group™| OH
Limit Exceeded Credit Hold Reason: | CDE CO Dollar Value Exceeds Credit Limit
) Allow Apply To Invoice Changes

Default Bank Code: | DM1

Annual Rate: 22.00 (O Use Preprinted Forms
Minimum Charge: 0.00000 Per Invoice:
O Charge Minimum Per Debit Memo:
) Compound Charges Per Credit Memo:

Retumed Checks
Returned Check Fee Type: |Amount @ Generate Debit Memo Per Invoice

Returned Check Fee Value: 0.00000 () Generate Payment Adjustment for Returned Check

AR Payment Import Archive Path: | Wscowslu7\Devel\Toolsef\ReportiArchivel

E-mail: | infori@hotmail.com

You must specify a multi-site group on this form. Only records for sites in this group are
considered when performing Accounts Receivable payments and quick invoice payments,
and when consolidating A/R posted transactions.

You can set up a customer prefix that indicates the originating site as well as the type of
record. For example, you can use ClI as the prefix for customer numbers local to the ILL site
and CC for customers local to the CAL site. If you have global customers, you could have one
site that can create only global customers, and use the prefix CG in that site. For more
information about prefixes, see the Multi-Site Planning Guide.

A credit hold reason code can be specified here but is not defined yet. You can return to this
form later to select the appropriate code.
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3 Atthe sites, set up Accounts Payable Parameters.

O Accounts Payable Parameters

(===
eIl Accounts  Landed Cost Accounts Misc 1099 EFT  Report Templates
Vendor Prefix: Multi-Site G'oup:"' CH
Aging Basis: | Due Date Surcharge Factor™|  1.0000
== -61| Days Title: | Due 61+ () Allow Exchange Rate Update
== -31| Days Title: | Due 31-60
== 0| Days Title: | Due 0-30
== 30| Days Title: | Late 1-30
== 095 | Days Title: | Late 31+
Remittance Advice
&) Wire O Manual
M EFT & Draft
Vendor
Bank Code: | BK1
Terms: | 3% 3M0 Net 30
Salesperson
Classification

You must specify a multi-site group on this form. Only records for sites in this group are
considered when performing Accounts Payable payments and quick voucher payments, and
when consolidating A/P posted transactions.

You can set up a vendor prefix that indicates the originating site as well as the type of record.
For example, you could use the prefix VI for vendors local to the ILL site and VC for vendors
local to the CAL site. If you have global vendors, you could set up one site that can create

only global vendors, and use the prefix VG in that site. See the Multi-Site Planning Guide for
more information about using prefixes.
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4 At the sites, set up Order Entry Parameters.

O order Entry Parameters (== ] =]

e el DIFOT  Integration  Report Templates

Order Prefic | co
Estimate Prefix |E
Invoice Length: 10

DO/BOL Length: 20 Builder Invoice Prefix:

DOIBOL Prefix: | DO

5td Due Period” 30 (O Use Alternate Net Price Calculation
(O Price from Originating Site O Print Packing Slip on Invoice
) Commission Due on Payment O Adjustment/Credit Memo Reason Required
(0 Compress Order Dist Journal on Post O Print Tax Invoice

O Allow Customer Order On Multiple Batches (4 Track Pick List Date

Order Dist Compression Level. None Default Ship Method Group: | Default

Export Document Prefix: | EX

xport Document File Extension: | txt
Export Document Directory: | WUSCOT\DevelToolsetiQutput
Order Text 10| Thank you for doing business with Progressive Cycles. Qur
Order Text 2: | new XT Series Racing Cycles are now available. See the

Order Text 27 | anclosed brochure for complete details.

e Specify the invoice number length in the Invoice Length field. We recommend that you set
this field to 12, which is the maximum.

Caution: The invoice number length must be the same for all sites in the system. It must be
set at each site; it cannot be replicated to the other sites. When you enter a value here, the
system verifies it against the Invoice Length value set for other sites, if the other sites are
replicating at least one category containing the coparms_all table with this site.

After the Invoice Length field is set to a non-null value, the value can never be updated.

When you save the change, the system updates about 50 database tables, so it may take a
long time to process.

e If you plan to use delivery orders, specify the DO/BOL length.

e Site-specific prefixes are recommended if Centralized Order Entry, Invoice Builder, or
Accounts Receivable payments across sites will be performed. See the information on
prefixes in the Multi-Site Planning Guide.

e If you will use DIFOT (Delivered In Full and On Time) as a standard to measure delivery
performance in your supply chain, provide tolerances in the DIFOT tab.
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e If the Price From Originating Site field is selected, default item prices for CO lines are pulled
from the site originating the order. This allows you to maintain pricing in one centralized site.
Otherwise, the system pulls the default prices from the site that ships the order line item.

Caution: After you update the Invoice Length and/or DO/BOL Length and save the record, log
yourself and all other users out of Infor CloudSuite. This resets the session variables. Then use
the Configuration Manager utility (on the utility server) to publish form changes. This clears the
form cache on your users’ computers the next time the users log in to Infor CloudSuite.

e When you save this record, you might see a message that asks you to perform manual
replication of A/R data. If so, go to the Manual Replication Utility, select the A/R category, and
select the site(s) to which A/R data is being replicated. This ensures that the required data is
in the proper tables at the other sites.

5 Atthe sites, set up Purchasing Parameters.
'n Purchasing Parameters EI@

e ET Accounts  Report Templates

Builder PO Prefix: | Use PO Change Order: | Never @ Vendor Required On PO
PO Prefix PO Tolerance Over: (O Blind Receiving
Drop Ship Prefix: |D PO Tolerance Under: ® Amend Ordered PO
Update Current Cost: | Last (0 Use PO Tolerance % for Non-Inventory ltems
Builder Vioucher Prefix: Voucher Tolerance Under: 000 %
Ovoucher Authorization Voucher Tolerance Over: 0.00 %
PO Text 10 | Please accept our purchase order and furnish these items

PO Text 2 | subject to the conditions described above. Please sign and

PO Text 3: | return the acknowledgment copy.

PO Req Prefix |R (O Create PO Reqgs from Customer Order (O Create PO Reqgs from BOM
(O Create PO Reqgs from Transfer Order (O Create PO Reqgs from Job
Vendor Created PO Prefix: Vendor Created PO Req Prefix:

e Site-specific prefixes are recommended if Accounts Payable payments across sites will be
performed. See the information about prefixes in the Multi-Site Planning Guide.

6 Atthe sites, set up Transfer Order Parameters.

ETransfer Order Parameters =] =]

Transfer Prefis |T
Transfer Text 1:

Transfer TJ}Z

Transfer Test 3 |

e Site-specific prefixes are recommended to make it easier to determine which site initiates a
transfer order. See the information about prefixes in the Multi-Site Planning Guide.
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7 At the sites, if you will be using MRP or APS, set up Planning Parameters.

| Planning Parameters. [E
APS Advanced APS _Specific APS Options

Use CO or Fcre-:ast?"Eloth v| & Check PO Requisitions

Forecast Look Ahead: | 20| (O Create PO Reqgs from PLN
Forecast Look Behind: | | O Plan Planned Production Schedules
Reschedule Tolerances O Use Scheduled Times In Planning
PO In:| 5| Days Job In:| 1| Days O Plan Materials At Operation Start
PO Out | 2| Days Job Out: | 1 |Days @ Plan Intra-Site Transfers
# Buckets for erort:l 24| & Apply Shrink Factor
Fences & Apply Scrap Factor
30 Day Bucket Fence: | 129|
90 Day Bucket Fence: | 24u|
— (O Plan Stopped Job Orders
MPS Plan Fence: | 90|
— () Plan Stopped Customer Orders
Minimum Hours in Work Day- | a | 4 Plan Planned Customer Order Lines

MDAY Start: [ 1211472011 0 Plan Credit Held Customer Orders

MDAY End: | 4/1/2016

Refer to the online help and the Infor CloudSuite Industrial APS Configuration Guide for
information about how to set up these parameters for use in a multi-site environment.

8 Atthe sites, set up Inventory Parameters to determine how Infor CloudSuite handles inventory at
each site.

B3 Inventory Parameters

General Igontrol "EOM Import "Erodud Configuration " Containers " Labels l

M 0n Hand Meg Flag Irwertory LCL %: l:l (isstType E—
I LowrLevel On Line Inventory UGL %: l:l Actual

i i " Standard
¥ Track Pick List Date

Default wWhze: |[MAIN . r Compress IC DistJourn:

Default Location: |STOCK IC Dist Compression Level: |None -

I Casttems at'warehaust

EREN

Backflush Location: [FLOOR

Co-product hix Prefix: l:l ECN Use for Current BOMIRoutings: |Individual

Current Job Prefix: ECH Usze for Job BOMIRoutings: |Individual

ECH Usze for Estimate BOMIRoutings: |Individual

F- BOM Blank Char: l:l

Create Feature: |Prompted -

Feature Template: l |

Inventory Reszervation Process Step: [Pack Confirmation f

Shipping Location: [FIN-1 j I Print Barcodes On Pick |

Packing Location:

Note: You can choose to track the cost of items at the warehouse level rather than at the item
level (that is, for the entire site). Read the help to determine the consequences of this selection.
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9 Atthe sites, go to the Master Explorer>Modules>Codes>Parameters and open the other
parameters forms you have not yet accessed, to set up parameters appropriate for your system.

Master Explorer = My Folders
Maodules 1 Codes
Optional Modules » Customer
Roles 4 Employee
Pin Executive

Finance

Material

Portal

Production

Project

System

Vendor

Pin

Parameters

Queriges

Billing Terms
Commodity Codes
Countries

Currency Codes
Currency Rates

Delivery Terms

E-mail Types

Excise Currency Rates
Address Tax Code Defaults
Freight Charge Methods
Interaction Topics

15O Countries

Accounts Payable Parameters
Accounts Receivable Parameters

Data Collection Parameters

Demand EDI Parameters - Interface Setup
External Financial Interface Parameters
External Payroll Interface Parameters
Fixed Asset Parameters

Scheduling Parameters

General Parameters

Human Resources Parameters

Infinite APS Mode

Inter-Site Parameters

Inventory Parameters

MRP Mode

e Depending on your system, you might not need to set up some of these parameters.
e Some forms might require selection of data that is not yet set up. If so, return to finish the

setup of those forms later.

e When a Prefix field appears on a parameter form, you may want to specify a site-specific
prefix where appropriate, as described for the other parameter forms above.

10 After you update all parameters, log out of each site/entity and then log in again. This updates
system variables so that they contain the latest parameter information.
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Chapter 9: Setting Up Users and
Authorizations

If you plan to use a master site to maintain users for all sites on an intranet, set up the shared user

tables as described below and then perform the other steps in this chapter at the master site only. If
you are using Intranet Licensing, the users at all sites must also be defined at the master site. Then
the users must be assigned to license modules on the master site (through the User Modules form).

If you are not using a master site, skip the first step and perform the other steps in this chapter at
each site and entity to set up users.

Setting Up Shared User Tables

Note: Intranet Licensing must be set up at the master site and all participating sites before you share
user tables for the sites. Also, if you share user tables, all sites and entities in the same database
must be on the same intranet.

You can maintain user and group names and permissions, user-group mappings, user license module
assignments, and application-specific user information at the master site of an intranet. To do this,
you must share the user tables from all sites on the intranet; that is, set up views to the tables, which
only reside at the master site:

1 Log in to the master site for the intranet where you want to share user tables.
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2 On the Intranet Shared User Tables form, select the master site's intranet.

Elntranet Shared User Tables — 10l =
[otiaret Intranet: SHARED
1L R Master Site: ILL ILL Site

2 SHARED
Shareable User Maintenance Tables
Table Name Shared Processed Userld Column Groupld Column

2
3

]

Non-Shareable Tables Containing References to Userld or Groupld

Update

able M e Pr ssed Us (o Grou [
Table Name Referenced Id ocessed serld Columin Groupld Columin

1
2

3

Process Options
) Set up shared user tables Status:  User tables are not shared
Processing Step:

4 3

Two lists of tables display:

e The top grid lists user tables that can be shared. You can clear the Shared option for some
tables, but not all of them, as described below.

e The bottom grid lists tables that contain a column whose base domain is UserNames.Userld
or GroupNames.Groupld. The bottom grid is used during setup of shared user tables to
identify the tables and columns that may need to be updated if records that were formerly
defined in the Usernames or Groupnames tables in the non-master site are moved to the
master site, but with different Userld or Groupld values.

If you have custom tables that contain a column whose value comes from base domain
UserNames.Userld or GroupNames.Groupld, add your custom table and its associated ID
column to the Non-Shareable Tables grid. We recommend that your custom tables refer to the
Username or Groupname columns, rather than the ID columns, because the distinct list of
Usernames and Groupnames across intranet sites is always the same, whether they are stored in
shared tables or per site, and therefore no changes are required for data referencing this base
domain.

Select Set up shared user tables, which automatically selects Shared for all tables in the top
grid and Update Referenced ID for all tables in the bottom grid.

In the top grid, clear the Shared check box for any tables that you do not want to share between
sites.

Note: Be aware of how this works. For the Usernames, GroupNames, UserEmail, UserModules,
UserPasswordHistory, UserCalendar, and UserTask tables:
e If you do not share these tables on the Intranet Shared User Tables form, these tables are:
e Not shared across multiple sites, if one site per database
e Shared if there are multiple sites per database
e If you do share these tables on the Intranet Shared User Tables form, these tables are:
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e Shared across multiple sites, if one site per database
e Shared if there are multiple sites per database
For the AccountAuthorizations_mst, user_local_mst, and UserGroupMap_mst tables:
e If you do not share these tables on the Intranet Shared User Tables form, these tables are:
e Not shared across multiple sites, if one site per database
e Not shared if there are multiple sites per database

e If you do share these tables on the Intranet Shared User Tables form, then you can optionally
share each of these tables across multiple sites, regardless of whether each site is in its own
database or all sites are in the same database.

Click Process to copy information from the tables at the other sites to the master site's table,
delete the table from the other sites (creating views into the master site tables instead), and
regenerate the replication triggers for the other sites. (Removing tables and setting up views does
not happen if the non-master site is in the same application database as the master site.)

If you have many sites on this intranet or many users and groups, processing can take a while to
complete. The Processing Step area displays the system's progress.

During processing, the system validates link setup between the master site and the using sites of
an intranet. If it finds a problem, an error message displays and nothing is processed; fix the link
and then click Process again.

The Processed field indicates which tables have been processed - for example, if shared, they
are now resident only in the master site's database. (After a row on the form is marked as
Processed, subsequent "Process" runs do not reprocess that row.)

The Status field indicates that the user tables are either shared or not shared.

After processing all the tables and sites, the system regenerates the replication triggers at the
master site.

After processing is complete, you must reapply a valid license document on the master site.

In the master site, open the View Management form and regenerate views at the master site, so
that the views reflect the changes to table sharing.

In the master site, open the Trigger Management form and regenerate table triggers at the master
site.
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Update the "sa" User

On the Users form, select the "sa" user and add the Enter Out of Date Range group authorization.
This authorization can be used to limit journal entries incorrectly created to the wrong accounting

period.

E=l sers [E=5[ESE )
Uzer
Uszer ID
Uszer 1D: |sa | ¥ Super User
1 L UEE Uszer Description: ||
2[m)k | za T 1
Uszer Pagsword: | ]
3 SL_Internal X
¥ Confirm Pazsword: | |
“whorkstation DomaindD: | |
Editing Permissions: |Site Developer j User Modules | Row Authorizations.. | User Autharizations.. |
Groups | Additional Info " Login Information " E-mail Address " Source Control ]
Group Mame Group Description IFITE)
P P P Group
1 [n]» | Enter out of Date Range | Enter out of Date Range Group -
* r
Fiow Authorizations. .. | Group Authorizations. .. |
<« [ r

You also might be asked to select a Site Group for this user. Since this is a Super User, the group you
choose does not matter.

About the SL_Internal User

The SL_Internal user exists in every site. It is a multi-session internal user. You should not have to
modify any information about this user.

96 | Infor CloudSuite Industrial - Multi-Site Implementation Guide



Setting Up Users and Authorizations

Set Up Password Parameters

Use the Password Parameters form to specify password expiration and complexity rules for all users.
Be sure to explain the rules you choose to the users of your system.

O Password Parameters E]

O Enforce Mixed Case
O Enforce Number

O Enforce Special Character

Number Of Retries”[ 3
Lockout Duration (Minutes)” | 30
Password Length Minimum” |7
Password Length Maximum”| 30
Password Expiration Days’ |
Password Wamning Days
Password History Count”|

o .
Password Minimum Days:

The password parameter data is replicated as part of the Site Admin category.

Add Common Users

1 Inthe Users form, set up other common users - those who will be working in multiple sites. You
can also set up local users now, if you want.

These users are in addition to the sa and SL_internal users (and the repl_user, if set up in
Chapter 5, “Setting Up Replication at Sites and Entities"), which have full access to the local site

or entity.
E=l sers [E=5[ESE )
Uzer
Uszer ID
User |D: |robertz [ Super User
1 repl_user Uszer Description: |Flobert Zell
2 s User Passward: ™
3 SLolnternal | e
Sl Confirm Password:
4 jennyh X X
“whorkstation DomaindD:
S[n)k | robertz o o
* Editing Permizsions: | Full User ZI UserModuIesl Fow Authorizations.. | User Authorizations..
| Groups [Additional Info " Login Information "E-mail Address "Source Contral
Group Mame Group Description L)
P P P Group
ANOLA coounts Pavablel |Z| Accounts Payable Group ]
* ]
Fiow Authorizations. .. | Group Authorizations. .. |
<« [ r
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Note: If the user_local_mst table is not shared in the Intranet Shared User Tables form, then you
must update the multi-site group and other user fields at each site where the user record exists, even
for sites in the same database. If the AccountAuthorizations and/or UserGroupMap tables are not
shared, then you must update authorizations and groups at each site.

You must specify a default authorization group for each user.

e For entity users, the authorization group should be Entity Forms. This will prevent users
from doing anything in the entity that is not supposed to be done in an entity.

e For site users, select an authorization group. For now, select one or more of the default
authorization groups. On the Users form, select one or more authorization groups for
each user from the drop-down list. (Later, after you become more familiar with the system,
you may want to set up new groups that more closely resemble your needs. Do not
change the default groups!)

e To find out which forms are included in each default authorization group, go to the Groups
form. Select a group and then click Group Authorizations to list the forms that members
of this group can access.

e If you do not set up at least one authorization group for a user, then the user has access
to no forms, unless the user is set up with super user access.

You must specify a default multi-site group for each user. This is the default value that
appears in the Multi-Site Group field when this user opens the Item Availability form.

For mobile users, specify a Mobile Default Form on the Login Information tab. See the help
topic on setting up Infor CloudSuite mobile access for more information.

For developer users, if you are using a source control system, specify the user’s login
information for the source control system.

You cannot replicate the usernames or groupnames tables because those tables use identity
columns. However, to simplify the initial setup of multi-site users, you could add the multi-site
users and groups in one site, export the data to Excel spreadsheets, and import into sites and
entities in other databases.(See Appendix C, “Data Load To/From Spreadsheets," for more
information.)

For sites in separate application databases, the user password, e-mail addresses, and
workstation login can be set up in one site and replicated to the rest (through the
UserNamesRemoteUpdateSp in the Site Admin category). However, the user record,
assigned user module, authorization group and other required fields must already be set up at
the individual sites and entities.

If you have multiple sites/entities in one application database, any data stored in the non-
multi-site tables is shared across all of the sites and entities. This data includes the user ID,
password, and e-mail addresses, as well as some other fields. However, certain other fields
such as multi-site group must be set up at each site and entity, if those other fields are in
tables that are not being shared.

Warehouse (Whse) may be specified here but is not defined yet. You can return to this form
later to select the appropriate warehouse.

2 From the Users form, click User Authorizations to display the Object Authorizations for User
form, where you set up object authorizations for each new user record. Settings made here
override any group authorizations for this user.

Some of your users may require special access to certain forms that is not covered in the default
group authorizations. For example, the user robertz is in the Purchasing authorization group,
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3

which has full access to the Purchase Orders form. However, you do not want to allow robertz to
delete POs.

E Object Authorizations for User (Linked) =] =]
Uzer: |robertz Object Type: Form lz‘
Object Mame Delete Privilege Edit Privilege Execute Priviege  Inzert Privilege Fiead Frivileg

1[n]» | PurchaseQrders |Z| Granted Granted Granted Granted

*

Component Privileges

If you decided during the Planning phase to use named user licensing, return to the Users form
and select a user record. Click User Modules to go to the User Modules form where you can set
up licensing for the selected user.

Repeat this step for each user in the site or entity. Use the Licensing spreadsheet from your
Planning phase to help with this.

=] User Modules (Linked) [ e ]
[l:eiblone User Mame: |robertz

1[n)» | robertz Module Mame: [SyteLineTransMultiSite lz‘

*

If you are using Intranet Licensing, the User Modules form is available only at the master site and
not at the participating sites.

See the Infor CloudSuite Industrial Licensing Guide for more information about how licensing
works.

If the site will allow access from an Infor CloudSuite portal, set up the portal users as described in
the Portal Setup and Administration Guide.

Run the User Authorization Report form if you want to have a list of authorization information for
each user, for auditing purposes.
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Copy Users Utility

If you have many common users between sites, in certain cases you can set up the users in one site
and then use the Copy User Tables utility to copy them to other sites.

For more information about how the utility works and when you can use it, see Appendix G, “Copy
User Tables Utility.”

Adding External Users

External customers or suppliers may be added as users on particular sites. (Since they will log in
remotely via the internet, the web server through which they will log in should be configured to use
https, so that data being transferred over the intranet is encrypted.)

Set up these users in Infor CloudSuite Industrial using authorizations that limit their access only to the
specific forms you want them to view. You may also want to limit their object authorizations to view-
only, as described on page 98.

Setting up Users to Work with Infor Ming.le/IFS

See the Infor CloudSuite Industrial Configuration Guide for Infor Ming.le for information about using
BODs to transfer user information between Infor CloudSuite and Infor Ming.le/IFS.
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In each site, set up the following data. The forms listed below add data to supporting tables that are
used when entering customer, vendor, and item information, creating transactions, and so on. Your
company may not use some of the following data; in that case, you can skip those forms.

Note: Be careful about the order in which the data is defined, so that table dependencies are not
violated, which will prevent records from loading. For example, product codes must be defined before
distribution accounts are defined, both of which must precede the definition of items. Items must be
defined before routings, BOMs, CO and PO lines, jobs, and so on.

The forms are generally listed in the order the data should be entered because of data dependencies.

Offices
Companies: optionally includes CEO (from Employees, which is not available until later)

Divisions: requires Company and Office, optionally includes Div Manager (from Employees,
not available until later)

Departments: optionally includes Company, Office and Manager (from Employees, not
available until later)

Price Codes: you might want to skip until later when items are defined
Project Cost Codes
Product Codes: optionally includes Price Code and Project Cost Code.

Even though the account fields are not required fields in this form, you must specify them
now. When you add items later, the product cost requires these associated accounts.

Nature of Transaction Codes (NOTC)
Secondary NOTC

Carrier Codes

Ship Via Codes: optionally includes Carrier Code
Delivery Terms

Warehouses: optionally includes Prov/State, Country, NOTC, Secondary NOTC, Delivery
Terms and Ship Via

Distribution Accounts: requires Warehouse and Product Code (In-Transit account values
default from the product code)

Tax Codes: requires Tax System - but there is a default Tax System 1 defined here, optionally
includes Tax Jurisdiction

Tax Systems: requires Tax Code
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Tax Jurisdictions: requires Tax System, optionally includes EC Code (from Countries form)
and Vendor number (not available until later)

Billing Terms

Reason Codes: there are many of these - use Form>Open and filter on reason to find them
all. Some of them optionally include NOTC and Secondary NOTC

Scheduling Shifts
Resource Types

Resources: requires Resource Types and Shift Exception ID, optionally includes Item (not
added until later), Scheduling Shift, Fixed Asset Number (which in turn requires other data)

Resource Groups: requires Resources

Work Centers: requires Department, optionally includes Scheduling Shift and Resource
Group

Locations: optionally includes Work Centers

Unit of Measure Codes: some U/M information is replicated between sites when the sites are
replicating the Centralized Order Entry, Inventory/Transfers, Purchase Order Builder, or
Voucher Builder categories

Shift Codes

Commodity Codes

Language IDs

Multi-Lingual Ship Via

Multi-Lingual Terms

Unit of Measure Conversions: requires Unit of Measure Codes
End User Types

Customer Types

Vendor Categories

Fixed Asset Class Codes: optionally includes Department
Printers

Territories

Sales Periods

Campaign Statuses, Campaign Types

Lead Statuses

Opportunity Task Types, Opportunity Sources, Opportunity Statuses, Opportunity Stages
E-Mail Types

Lot Attributes

Manufacturers

Electronic Signature Setup

Electronic Signature Authorizers
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Simplifying the Data Load Process

In many cases, you can create a spreadsheet based on the grid view of a form to copy and paste the
supporting data into Infor CloudSuite. See Appendix C, “Data Load To/From Spreadsheets," for more
information.
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Data Loads and Replication

Note: If the following statements are true, you might want to turn off replication before loading
operational data, in order to speed up the data load:

You are loading large amounts of data into tables, AND

Those tables have triggers replicating to _all tables, AND

Your system is replicating those _all tables between sites, AND

Those _all tables reside at the local sites rather than at one master site.

Also, if there are possible conflicts between data records being loaded at different sites (for example,
different customers with the same number), you might want to turn off replication before loading the
data, in order to minimize errors, and then deal with the conflicts later.

In these cases, go to the Sites/Entities form’s Link Info tab and disable replication between sites
before loading the data.

Atfter the load is complete, enable replication and run the Manual Replication Utility for the necessary
replication categories.

Set Up Shared Customers, Vendors, and ltems

You might want an administrator to control adding, updating, and deleting shared customers, vendors,
and items across the system. Keep in mind that each site can control its local customer records, and
these records are independent of other sites.

Add Shared Customers Using a Master Site

If you have set up a master site, use the Multi-Site Customers form at the master site to add
customers for all sites in the intranet. Instructions for using this form are in the online help.
Appropriate replication rules must be set up between the sites in order for the form to work. See the
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chapter on Master Sites in the Multi-Site Planning Guide for information about the replication rules
required.

Add Shared Items Using a Master Site

If you have set up a master site, use the Multi-Site Items form at the master site to add items for all
sites in the intranet. Instructions for using this form are in the online help. Appropriate replication rules
must be set up between the sites in order for the form to work. See the chapter on Master Sites in the
Multi-Site Planning Guide for information about the replication rules required.

Add Shared Vendors Using a Master Site

If you have set up a master site, use the Multi-Site Vendors form at the master site to add vendors for
all sites in the intranet. Instructions for using this form are in the online help. Appropriate replication
rules must be set up between the sites in order for the form to work. See the chapter on Master Sites
in the Multi-Site Planning Guide for information about the replication rules required.

Copy Customers, Vendors, or Items Using a Master Site

You can define a customer, vendor or item record in one site and then select Actions > Multi-Site
Copy in the Multi-Site Customers, Multi-Site Vendors, or Multi-Site Items form to copy the record to
other sites that are in the same intranet and multi-site group as the master site. BOMs are not copied
with item records when you use this method; use the Multi-Site BOM Builder form to copy the BOM to
the other sites.

Add Shared Customers, Vendors, and Iltems Without a Master Site

As described in the Multi-Site Planning Guide, some customer, vendor, and/or item data may be
replicated when a new customer, vendor or item is added. However, the new record is not
automatically displayed in the Customers, Vendors, and Iltems forms at the other sites. You must add
it as described below.

Add Shared (Global) Customers - No Master Site

When a customer record is added in one site, it does not automatically populate in other shared sites.
If you want a customer to exist in multiple sites, first create it in one site and then add the existing
customer into other shared sites using these steps:
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Note: In the following description, "sharing sites" means all categories that contain the custaddr table
are being replicated between the sites.

1 In one site, go to the Customers form. Add and save the new customer records. The customer
number, name, and some other data from the custaddr table is replicated to sharing sites.

2 Atthe other sites, go to the Customers form and select Actions>New.

3 Specify the customer number. The customer name, address, and some other information from the
custaddr table displays.

4  Fill in the rest of the information manually in the Customers form at the sharing site.

Add Shared (Global) Vendors - No Master Site

When a vendor record is added in one site, it does not automatically populate in other shared sites. If
you want a vendor to exist in multiple sites, first create it in one site and then add the existing vendor
into other sharing sites using these steps:

Note: In the following description, "sharing sites" means all categories that contain the vendaddr table
are being replicated between the sites.

1 Inone site, go to the Vendors form. Add and save the new vendor records. The vendor number,
name and some other information from the vendaddr table is replicated to sharing sites.

2 Atthe other sites, go to the Vendors form and select Actions>New.

3 Specify the vendor number. The vendor name, address and some other information from the
vendaddr table displays.

4  Fill in the rest of the information manually in the Vendors form at the sharing site.

Add Shared (Global) Items - No Master Site

When an item record is added in one site, it does not automatically populate in other shared sites. If
you want an item to exist in multiple sites, first create it in one site and then add the existing item into
other sharing sites using these steps:

Note: In the following description, "sharing sites" means the Centralized Order Entry category and/or
the Inventory/Transfers category are being replicated between the sites.

1 Inone site, go to the Items form and add and save the items.
The item numbers, descriptions and U/M values are replicated to sharing sites - but the new items

will not automatically appear in the ltems form at the sharing sites. This information will, however,
appear in the sharing sites’ Global Items form.

2 Inthe sharing sites, go to the Items form and select Actions>New.

3 Specify the item number. The system enters the default values from the Global ltems form into
these fields: Item, Description, and U/M.

4  Fill in the rest of the item record manually at the sharing site.
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The Global Items form also contains a default Shipping Site, which is used to determine how the
Customer Order Line ship site defaults when entering a centralized order for the item.

Typically, shared sites have identical Global Items default values when all sites are within the same
country. If sites are in different countries, the Description and U/M fields can be updated as required.

Alternative Methods - Copying Records

Another way to duplicate vendor, customer or item records in multiple sites is to create the records in
one site, export them to a spreadsheet, and import the spreadsheet into the same form at the new
site. (Make sure the form's grid columns are arranged in the same order at both sites.) See Appendix
C, “Data Load To/From Spreadsheets," for more information.

If your sites are accessible through a single computer, you also may be able to use the right-click
Copy feature to copy the item rows from the Customers, Vendors, or Items form on one site and then
select Edit>Paste Rows Append to add them at the other site.

Set Up Employees

On the Employees form, enter information about each employee. Fill in at least the required fields,
which are used in other areas of the system.

Set Up Other Operational Data

1 In each site, set up current routings and BOMs.
2 In each site, set up beginning balances for accounts in the Journal Entries form.

3 In each site, set up units on the Units form.
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12

Once you have your basic Infor CloudSuite multi-site system set up, you can install and configure
other modules and products according to the documentation listed below. Note that this may not be a
complete list of all available modules and products.

To set up this
APS

Application Event System
Infor Bl for Infor CloudSuite

Infor ION Business Vault,
Business Analytics
Manufacturing Foundation,
and Infor Reporting

Infor CPM (PM 10)

Country Packs/
Localizations

Refer to this information

Infor CloudSuite Industrial Installation Guide, APS Configuration
Guide for Infor CloudSuite Industrial, online help

Application Event System Guide, online help

Infor Bl for Infor CloudSuite Industrial Installation Guide, Infor Bl for
Infor CloudSuite Industrial Administration Guide

Infor CloudSuite Industrial Configuration Guide for Infor ION
Business Vault

Infor CloudSuite Industrial Integration Guide for Infor CPM

If separately installed: Infor CloudSuite Industrial Country Packs
Installation Guide and any appropriate documents.

If installed as part of Infor CloudSuite: online help.

Credit Card Interface

Infor CRM Back Office
Edition

Infor CloudSuite Industrial Credit Card Interface Implementation
Guide, online help

Infor CloudSuite Industrial Integration Guide for Infor CRM Back
Office Edition

Data Collection background
tasks

Industry Packs

online help

If separately installed: Infor CloudSuite Industrial Industry Packs
Installation Guide and any appropriate documents. If installed as
part of Infor CloudSuite: online help and user guides.

Infor EAM

Infor CloudSuite Industrial Integration Guide for Infor EAM
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To set up this
EDI

EFT (bank reconciliations,
customer payments)

e-Commerce

Infor CloudSuite Industrial
Enterprise Financials
(SunSystems interface)

Inforce

Infor Framework FAX
Service

Infor Global Financials
(Varial)

Refer to this information

Online help
Online help

Infor CloudSuite Industrial Integration Guide for Infor e-Commerce

Infor CloudSuite Industrial Enterprise Financials Interface
Installation and Setup Guide

Infor CloudSuite Industrial Integration Guide for Inforce

Infor CloudSuite Industrial Installation Guide

Infor CloudSuite Industrial Integration Guide for Infor Global
Financials

Infor ION Infor CloudSuite Industrial Configuration Guide for Infor ION

Infor Local.ly Infor CloudSuite Industrial Integration Guide for Infor Local.ly

Portals Portals installation and administration guides

Microsoft Office Infor CloudSuite Industrial Microsoft Office Integration User Guide,
online help

Infor Ming.le Infor CloudSuite Industrial Configuration Guide for Infor Ming.le

Mobile Online help, mobile user guides

.NET Web Service
Online help
Payroll Interface

Infor PLM
or Infor PLM Accelerate

Infor Product Configuration
Management

Product Configurator
(Features and Options)

Infor Motion Road Warrior

Infor SCE Warehouse
Management

Tax Interface

Infor CloudSuite Industrial Installation Guide
Infor CloudSuite Industrial Installation Guide
Online help

Infor CloudSuite Industrial Integration Guide for PLM, online help
Infor CloudSuite Industrial Integration Guide for PLM Accelerate

Various PCM installation, upgrade, integration, and reference
guides, Infor CloudSuite online help

Online help

Infor CloudSuite Industrial Integration Guide for Infor Motion Road
Warrior

Infor CloudSuite Industrial Integration Guide for Infor SCE
Warehouse Management

Infor CloudSuite Industrial Tax System Interface Configuration
Guide, online help
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To set up this Refer to this information
Infor Time Track Contact Infor Consulting Services
Infor Warehouse Mobility Contact Infor Consulting Services

Some of these products are installed as part of the Infor CloudSuite installation, but are licensed
separately. These products are licensed for an application database, but you must also use the
Optional Modules form in Infor CloudSuite to enable the products for each site. For more information,
see the Licensing guide.
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Appendix A: Troubleshooting

Handling Replication Errors

Errors During Transactional Replication

Validation errors relating to transactional replication generally display during data entry or saving of
transaction records at the local site, and do not allow the user to continue.

However, if transactional replication appears to not be working (that is, the data is not being moved to
the target site as expected) and the cause is not immediately apparent, use the “Replication
Troubleshooting Checklist” on page 114 to help find the problem.
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Errors During Non-Transactional Replication

If errors occur when sending or receiving XML request documents through Infor CloudSuite’s
replication system, the following processes handle the errors.

Replication - Outbound Flows

Replication
Replicator Queue
Listener
Destination
External
Application > Outbound System or
Database Queue Application
Intranet
Replication
Tool
Replication - Inbound Flows
Replication Replication
Queue Queue
Listener Listener
Target Site Source
Database < Inbound | External
Replication Queue System or
Errors Application
Form Replication Intranet
Tool
System
Boundary
Legend

‘ ‘ ‘ ‘ Application in control of
this stage of the flow

G:D Error handling application

for this stage of the flow

Replication Troubleshooting Checklist

Problem: Replication does not seem to be working. For example, a newly added item is not
available from a drop-down menu in another, replicating site.

Solution: View the appropriate _all table(s) using SQL Server tools, to determine if data is being
populated. For our example problem above, view the item_all table. If replication is not working, the
table typically will not contain the newly entered data records. In this case, there probably is a
problem with the replication rules.

For replication problems, check the following areas:

1. Configuration Manager utility (page 26): Verify, for each site and entity, that either 1) a default
configuration name is defined for that site on the Sites/Entities form, or 2) you have created at
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least one configuration name that exactly matches the site/entity ID, including case, and that uses
the site/entity’s application database.

Replication Rules form (page 46 and 62): Make sure the rules are set up properly between the
site where the data was added and the one where it was supposed to appear.
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Are the proper categories being replicated? Use the following table to see what types of results to
expect on the target site for each replicated category.

Category
AP

AR

Expected results on target site (for forms with Site or Site Group fields)

Posted A/P vouchers, adjustments and payments from source sites are visible
on view forms.

A/P reports contain data from source sites.

_all tables contain account, currency, item, journal, period, vendor and tax
information from source sites.

Posted A/R invoices, debit memos, credit memos and payments from source
sites are visible on view forms.

A/P reports contain data from source sites.

_all tables contain account, currency, item, journal, period, customer and tax
information from source sites.

CCI Centralized
Order Entry

Centralized
Order Entry

Customer Portal

Credit card authorization information is replicated from the source site.

Customer orders with lines that have a local ship site are visible.
Transfer orders to or from the local site are visible.

_all tables contain customer, customer order, account, currency, item, job,
period, purchase order, project, transfer order and tax information from source
sites.

Portal users can see item pricing. B2B users can see that prices are from
multiple sites.

Dimensions

ESB

EXTFIN

EXTFIN
Customer

EXTFIN Vendor
G/L

Initialize _All
Parameters

Inventory/
Transfers

View dimensions and attributes at other sites.

Data is received in other BOD-enabled application; acknowledgement data is
received in Infor CloudSuite.

Not typically used between Infor CloudSuite sites.

Not typically used between Infor CloudSuite sites.

Not typically used between Infor CloudSuite sites.

Financial and G/L reports and views show data from source sites.
_all tables contain ledger, account, currency, period, and journal information
from source sites.

N/A. Used only during replication setup.

Transfer orders to or from the local site are visible.

_all tables contain account, currency, item, job, period, and transfer order
information from source sites.
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Category

Invoice Builder

Expected results on target site (for forms with Site or Site Group fields)

Invoices for customer order shipments and returns can be created at target
sites.

Journal Builder

Pending journal transactions created by Journal Builder in source site appear in
the local site.

Journal Builder site can validate data from the local site.

Ledger
Consolidation

Ledger Detail

Manufacturer
Item

Ledger records are consolidated from source sites when invoked.

_all tables contain account, currency, and period information from source sites.
Ability to drill down into G/L records from remote sites if transaction data is also
replicated.

_all tables contain account, material transaction and voucher pre-register
information from source sites.

_all tables contain manufacturer and manufacturer item information and cross-
reference information between manufacturer item and Infor CloudSuite item
records from source sites.

Multi-Site (home
forms)

Multi-Site
Customers

This applies to the Multi-Site Buyer, Controller, CRM, Customer Service,
Inventory Control, Production Planner, and Project Manager categories: On the
various Home forms, information from source sites is visible.

On Multi-Site Customers form, customer information defined on source sites is
visible.

Multi-Site ltems

Planning

PO-CO Across
Sites

On Multi-Site Customers form, item information defined on source sites is
visible.

Planning is invoked for source sites when specified.
Planning views include requirements and receipts for source sites.

Upon receiving a customer’s order, the demanding site automatically creates a
PO and links it to the source site.

Purchase Order
Builder

Service - Global
Incidents

Service - Global
Scheduling
Shared Partners

Service - Global
Service History

Service - Global
Units

POs are created in the local sites with data entered at the source site through
the Purchase Order Builder.

Purchase Order Builder site can validate data from the local site.

Incidents and associated events, reasons and resolutions are replicated from
the source site.

Scheduled appointments for Service are replicated from the source site.

Summarized history information about Incidents, service orders, and units are
replicated from the source site.

Units and their component configuration, warranty information and owner
history are replicated from the source site.
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Category

Service - Multi-
Site SRO Copy

Expected results on target site (for forms with Site or Site Group fields)

Users can trigger the copy of a service order from the source site to the target
site.

Shared
Currency

Site Admin

Vendor Portal

Currency information from source sites is visible.

Site/Intranet information from source sites is visible.
_all tables contain account information from source sites.

Vendor portal users can see purchase orders initiated from multiple sites.

Voucher Builder

Vouchers and adjustments are created in the local sites with data entered at the
source site through the Voucher Builder.

Vouchers are created in the local sites with data entered at the source site
through the Manual Voucher Builder.

Voucher Builder site, or Manual Voucher Builder site, can validate data from the
local site.

a. View the Replication Rules form in the source site (for example, if you're expecting to see
CAL data in ONT, view the CAL database), and determine if there is a rule set up with Target
Site equal to the site where you expect to see the data, and with Category equal to the
category as determined above.

b. If such a record does not exist, this means the behavior was expected. You can create a new
rule if desired, and retest to verify that the data was passed over.

c. Ifthe record exists, check its Interval Type:

e If the Interval Type is Transactional, there may be another problem with the replication
setup. Continue through the other steps in this check list.

e If the Interval Type is Immediate, there may be a problem with the setup of the replication

services.

e [f the Interval Type is something other than Transactional or Immediate, wait until the time
specified in Start Interval At before testing again. If the interval time has passed and the
change has still not occurred on the target machine, there may be a problem with the
setup of the replication services.

3. Sites/Entities form (page 46 and 62): Make sure the database name and the linked servers (for
transactional replication) or user maps (for non-transactional replication) are set up correctly.

4. Replication Management form (page 47): You must click the Regenerate Replication Triggers
button on this form after any replication rules have been changed. Failure to do so will result in
replication not working properly.

5. Find Replication Setup Issues form (page 125): Use this form to find problems relating to the
setup of replication from the current site to another site/entity for a particular database table or
stored procedure.
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10.
11.

12.

Not all problems found by this utility are valid in all situations. For example, it checks to see if a
user name is set up between the sites, which applies only if non-transactional replication is being
used.

Replication Errors form (page 124): This form shows the data that failed to submit to a target site
during non-transactional replication. Use the form to fix and resubmit data, or delete it.

Replication Tool (page 122): This tool on the utility server is used to troubleshoot non-
transactional replication.

ReplicatedRows3 and ShadowValues tables: When something is to be replicated through non-
transactional replication, it gets copied to the ReplicatedRows3 and ShadowValues tables. (See
the Replication Reference Guide for details.) If the data is not there, it is likely that either your
replication rules aren’t set properly or that you need to click the Regenerate Replication Triggers
button on the Replication Management form.

Services: If you are using non-transactional replication, make sure the Infor Replication Queue
Listener and Infor Replicator services are started on the utility server.

MSMQ or Message Queuing: Turn on journaling.

Event Viewer: Check the event viewer in the Windows Administrative Tools on the utility server or
database server. The events that are logged may give you a clue about where replication failed.

UETs: If you are using user extended tables, and the UET information is not replicating properly,
see the information about UETs and _all tables in the Replication Reference Guide.

Common Replication Solutions

Problem: System performance is slow and you suspect replication may be causing this.

Solution: Check the following:

1.

2.

Use the stored procedure sp_spaceused (in the Master database) to determine which tables
consume a lot of space.

If there are _all tables (that is, replicated data) that contain very large numbers of records, then
make sure you are not replicating unnecessary data. See the Replication Categories chapter in
the Replication Reference Guide, particularly the information about replicating financial data.

Also look at the descriptions of how the tables in each category are used. If your large _all tables
are used only for reports that you rarely or never require, you may be able to remove that object
from the category.

Note: Before making changes to replication categories, seriously consider requesting help from
your Infor CloudSuite Industrial provider or Infor Consulting Services.

See also the information on improving system performance in the Infor CloudSuite Industrial
Administration Guide.
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Problem: Replication failure due to SQL Linked Server error. If your system returns an error like
one of these, the local server probably no longer has a link to itself:

e Server’servername' is not configured for Data Access. Distributed Transaction Completed.
Either enlist this session in a new transaction or the NULL transaction.

e New transaction cannot enlist in the specified transaction coordinator.

e The operation could not be performed because the OLE provider 'SQLOLEDB' was unable to
begin a distributed transaction.

Solution: To fix this problem, run the following SQL commands on the App database:

exec sp_ addserver servername, LOCAL
-—- restart SQL Server.
EXEC sp_serveroption 'servername', 'Data Access', 'True'

Replace servername with the name of the local server.

Message: Invalid Column name UF_xxxx. If your system returns an error message similar to this
during replication, you may have user extended tables (UETs) set up in one site but not in another.

Solution: You must have identical schemas in all sites and entities to replicate data. If your system
includes User Extended Tables (UETs), consider the following when replicating data to other sites.

If one site contains UET modifications to a table, but the same table in another site does not contain
those modifications, errors probably will be generated during replication of that table’s data from one
site to the other.

For that reason, before you replicate data between sites, you should copy any UET schema changes
to all sites involved in the replication. A stored procedure, ExportUETClassSp, assists in handling this
process. See the document Modifying Infor CloudSuite Industrial for more information and a copy of
the script used to create the stored procedure.

Problem: Outbound BODs are not being sent from Infor CloudSuite Industrial to another
system.

Solution: Follow these steps to determine the cause:
1. Does the BOD appear in the Replication Document Outbox?

(BODs are saved in the outbox after processing only if the BOD service is configured to not delete
them.)

If Yes, continue to the next step.
If No, then do this:
a. If this is a multi-site system, verify that you are checking the inbox on the "bootstrap" site; that

is, the site defined in the configuration designated as the bootstrap in the Service
Configuration Manager utility.

a. From the Infor CloudSuite utility server, run the LogMonitor utility.

b. In the Infor CloudSuite application, perform the processing that should send the BOD. (See
the Replication Document Outbound Cross References form for a list of the application events
that generate the BOD.)
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2.

c. Inthe LogMonitor utility, look for ReplQListener log information that might indicate an error in
the BOD processing.

Is the Processed check box selected?

If Yes, the BOD was picked up by the BOD service. Check in that application(s) for details.

If No, then there is a problem that is preventing the BOD service from picking up the message;
either the service is not running or the configuration and deployment of the sending/receiving
applications is not set up properly in the receiving application(s).

Problem: Inbound BODs are not being received or processed by Infor CloudSuite Industrial.

Solution: Follow these steps to determine the cause:

1.

Does the BOD appear in the Replication Document Inbox?

(If there are many documents in the inbox, it can be difficult to find the BOD because currently you
cannot filter by BOD name.)

If Yes, continue to the next step.

If No, then something prevented it from being delivered by the BOD service:

e If this is a multi-site system, verify that you are looking at the inbox on the site designated in
the Inbound Bus Configuration field of the Service Configuration Manager.

e Check the BOD service logs to find failed message transmissions or information about why
the failure occurred.

e Check whether the BOD service is running.

e Check whether the configuration and deployment of the sending/receiving applications is set
up properly. See the appropriate integration guide for more information.

Is the Processed check box selected?

If Yes, and the expected information does not appear in the appropriate Infor CloudSuite form or
table, then there was an error in processing. Check the Replication Document Outbox for a
Confirmation BOD. A confirmation BOD indicates an error. Check the following areas to
determine the cause of the error:

e Windows application event viewer

e LogMonitor utility on the utility server, if it is running

If No, then either the Infor Framework Inbound Bus Service is not running, or it is still working
through previous messages.

Problem: After adding a site in a different database, replication is not working

If all sites were previously in the same application database, and you add a site in a different
application database, you must regenerate views and replication triggers, and repopulate _all tables.

Solution: Follow these steps in one site in each application database:

1.

In the Trigger Management form, leave the fields blank and click Generate to regenerate table
triggers. (This is not related to replication, but it must be done after adding a new site in another
database.)
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2. If any new replication rules were set up to/from the new site, open the Replication Management
form and click Regenerate Replication Triggers.

3. Inthe View Management form, leave the fields blank and click Generate to regenerate views over
tables.

4. Restart the replication services on the utility server.
5. Inthe Update _All Tables form, select all tables, set Site to the current site and click Repopulate.

Note: This step must be performed at every site and entity.

Problem: Error in Replication Document Manual Request Utility due to timeout

If you receive either of the following errors during generation of BODs through the Replication
Document Manual Request utility, then transactions are taking longer to run than the timeout values
set in Infor CloudSuite or other related applications and services.

Exception from load collection: Error processing an IDO request
(Protocol=Http, URL=http://jokerswild/IDORequestService/RequestService.aspx):
The remote server returned an error: (500) Internal Server Error.

or

The transaction has aborted.
Transaction Timeout

Solution: For a list of timeout values that can be reset, see the chapter on improving performance in
the Infor CloudSuite Industrial Administration Guide.

Problem: Multi-Site Customers, Items, or Vendors forms are not showing drop-down values
for the selected site

Solution: Make sure that the replication rules are set up between the sites as described in the online
help for the multi-site form. Then regenerate the replication triggers at each of the sites involved.

Forms and Utilities Used to Troubleshoot Replication

Replication Tool (Inbound or Outbound Flow)

If errors happen while Infor CloudSuite replication is processing an inbound or outbound request, you
can use the Replication Tool on the utility server to:

e View, correct, and resubmit inbound and outbound XML request documents
e View the status of sites linked to this site for replication

The Replication Tool can be used to view errors in any XML being sent from Infor CloudSuite
Industrial to a different Infor CloudSuite intranet or an external system. For most operating systems,
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navigate to All Programs > Infor > Tools > Replication Tool. For Windows Server 2012, find
Replication Tool under Apps.

Repgcation Tool nm |'_ |

Manage Dutbound Replication Errors

Manage Inbound Replication Emors

Outbound Sites Status

Help Exit

Service Configuration Manager (Setup)

Before you run the Replication Tool, use the Service Configuration Manager utility to configure
replication options on the Replication tab. Then click Save to save these settings in the service
configuration XML file specified on the General tab.

£ Service Configuration Manager. nﬂ |'-_||E|PS__<|
General | Evert Service | Replication |TaskMan
Fieplicator
Configuration: | w
[Dead Messages Directory: | | Browsze...

Use Default Directary

Retry Queue Directany: | | Browse...

Use Default Directory

Site Retry Delay [zeconds]: l:l

Meszage Editor: | H Browse... ]

Failure Matification

& Mone
O E-mail E-mail Address: | |
O Event Ewent Mame: | |
Motification Sender Address: | |
Fieplication Directory: |E:\Documents and Settings\all Uzers\Application Data\Mongoose | [ Browse... ]
Inbound Bus
Configuration: | w
[ Save ] [ Exit ] [ Help ]

Service Configuration File Path: C:\Documents and Settingsiall Users\Application DataiMongooseiMongooseServiceConfigs. xml

Instructions for using the Replication Tool and Service Configuration Manager are found in their online
help.

Infor CloudSuite Industrial - Multi-Site Implementation Guide | 123



Troubleshooting

Replication Errors Form (Inbound Flow)

During non-transactional replication, if an XML document makes it into an Infor CloudSuite intranet, is
retrieved from the inbound MSMQ by the Replication Queue Listener, but fails when executed against
the target site, its errors are displayed in Infor CloudSuite Industrial’s Replication Errors form on the
target site. Generally these documents contain valid login and target site information but are failing
for another reason.

If an inbound XML document fails before that point, you can view and correct it through the
Replication Tool described above.

E Replication Errars (Filter In Place) EI@
Gelact = sit Obisdt N Obiect T Operation Operation u
[=1=] rom oie ]=] ame E ype Number Type e
OH itern_all Takle 1 Insert 1
b
Fesubmit

Use the form to fix and resubmit the data. If the update succeeds this time, the data is removed from
the ShadowValuesErrors table; if it fails again, it will remain in the table.

The fields of interest are:

e From Site: Site where the record orginated.
e Object Name/Object Type: Name and type of record to be replicated (for example, co table).

e Operation Number: Distinguishes different elements in the errors. For example, an insert of an
item record might use several lines of old and new values, all with the same Operation Number.

e Operation Type: Type of operation: insert, update, delete, or method call.

e Line: Indicates which line of data for a particular record contained the error. The data is stored in
rows of 55 name/value pairs, so for example, if there are 85 columns of data, there will be 2 lines.

e Old/New: Indicates whether a particular row of the collection represents the old or new values.
For updates, the old values are also displayed.

e Error: Text of the error message received when this record was submitted.
e Label: Label seen on forms.

e Value: Data for a particular column. For example, the column "Description" might have data "bike
seat" as a value.
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Find Replication Setup Issue

If you know that a specific object (for example, the item_all table) is not replicating changes from the
current site to another site, use this form to help troubleshoot why replication is not occurring.

You enter an object name and type (a table, stored procedure, or XML document) and select the
remote site name. When you click List Issues, any setup errors for that site/object combination are

listed.
E Find Replication Setup Issue EI@
ObjectName:  no_table Object Type:  Tahble E| To Site il E

e

Message

Replication Category that has [Replication Category Object: no_table] does not exist

Replication Rule that has [Replication Category Object: no_takle] and [From Site: Demo] and [To Site: Ml does not exist
Intranet thet has [From Site: Demo] does not exist

Intranet thet has [To Site: M does not exist

User Mame that has [From Site: Dema] and [To Site: MI] does not exist.

Some of the setup problems that may be displayed include:

The From Site or To Site does not exist in the site table.
No replication category contains the specified object (table, SP, etc.).

No replication rule exists for the specified From Site and To Site, and for any category that
contains the specified object.

A rule exists for a category using the specified object, but the rule is currently disabled on the
Replication Rules form.

Replication is currently disabled between the specified From Site and To Site on the Sites/Entities
form.
No replication trigger exists for the specified object (if it is a table), or the trigger is disabled.

The To Site has not been set up with a linked server name on the Sites/Entities form or through
the Infor CloudSuite Industrial Configuration Wizard. (Transactional replication)

Note: Transactional replication checks are made only if at least one transactional replication rule
is enabled at this site.

The To and From sites are on different database servers, and the To Site’s database server has
no link to it from this site’s database server. This is established through the Linked Servers node
in SQL Server. (Transactional replication)

The To Site’s database name is not specified on the Sites/Entities form. (Transactional
replication)

The user name specified for this From Site and To Site does not exist. (Non-Transactional
replication)
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e The replication user name is not a super user or has not been given access to the proper license
module and group. (Non-Transactional replication)

e The To Site and/or From Site does not have an Intranet defined on the Sites/Entities form. (Non-
Transactional replication)

e The To Site's intranet has no URL defined on the Intranets form. This is a problem only if the To
Site is on a different intranet than the From Site. (Non-Transactional replication)

If no problems are found, the replication triggers may just need to be regenerated.

Troubleshooting Other Setup Problems

You may encounter other error messages during implementation. One common message and its
solution is described below.

Message: Maximum Number of Databases Used for Each Query has been Exceeded

Close and restart the Infor CloudSuite Industrial session where the error occurred. Retry the
procedure you were running at the time of the error.

If you still get the error, close all open Infor CloudSuite Industrial sessions and restart only the one for
the configuration you were in when the error occurred. Retry the procedure that caused the error.

Framework Logging

All framework logging, from sources such as as WinStudio, TaskMan, Replicator, and the IDO
Runtime Service, is sent to a common logging routine. This log information can be viewed on the
utility server through the Log Monitor

(Start>All Programs>Infor>Tools>Log Monitor).

Note that information sent to the logs while the Log Monitor program is not running is not stored
anywhere. If a developer is using the IDO Runtime Development Server instead of the Log Monitor,
that program displays logging information.
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Note: Refer to the Support Web site for the latest information on requesting license keys for demo or
pilot databases.

Before you "go live" with a multi-site environment, you probably want to set up a test environment,
possibly with your company's data. Follow the steps below to set up a multi-site test environment with
transactional replication:

1. Create one test site. You have 2 choices:

e Create an initialized application database that contains a “demo” site with data provided by
Infor. This is described in the installation guide.

e If you have already set up a site using this version of Infor CloudSuite Industrial with your data
in a "test" single-site environment, you can use that site as your initial site.

2. Repeat step 1 to create more application databases with different site names.

Note: The demo site has an invoice length to 10, so all of your test sites must have an invoice
length of 10 if you are using any demo sites in your multi-site test setup.

3. If you want to have multiple sites in a database, choose one of your existing application
databases as the target. Copy sites from your other application databases into the target
database, using the Add New Site to an Existing Database option in the Configuration Wizard.
See Appendix F, “Copying an Existing Site into an Existing Database (Multiple Sites per
Database)” for additional instructions

4. Create at least one forms database. If you use the same forms database for both your live and
test environments, be aware that any form customizations you make are then applied to both
environments.

5. Create at least one object database.

6. On the database server, run the Infor CloudSuite Configuration Wizard to link all the sites that you
want in your multi-site environment.

7. On the utility server, use the Configuration Manager to create client configurations that point to
the new sites.

8. On the utility server, use the Service Configuration Manager to set up monitoring of your new
configurations for TaskMan, non-transactional replication, and the application event system.
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9. Log into one site configuration on each application database as "sa" .

a. Inthe License Management form, enter the license for this database. If you need to request
special licenses, see the section in the Licensing Guide on licensing Demo and Pilot
databases.

b. In the Sites/Entities form, make sure the application and forms database names are set for
each site in this database.

c. Log out.

10. Log into each site and set up replication rules and/or shared tables between all the sites, as
described in Chapter 5, “Setting Up Replication at Sites and Entities."
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Requirements for Loading Data From Spreadsheets

If you have many sites with similar data to be entered at each site, it may make sense to load the data
into the system from a spreadsheet. The spreadsheet method only works well if you have smaller
volumes of data. It is much more difficult to deal with errors in spreadsheets when you are trying to
load a large number of records at once.

Note: Consider using Infor Consulting Services if you have larger volumes of data to load. Contact
your Infor representative for more information.

e Make sure the columns in the spreadsheet exactly match the order of the grid in the form, and
that the data is in the format required by the form. The best way to do this is to create several
sample records in the Infor CloudSuite form and then export them to a spreadsheet. Then use
that data as a template for the other rows. Or you may want to create a "demo" database and
export the sample data to use as a template.

In the template, you may want to hide columns for data that comes from calculated or read-only
fields so that you do not enter data into them accidentally. Do not delete these columns; otherwise
the columns will not match up when you paste them back into Infor CloudSuite.

e Make sure any supporting data has already been loaded. For example, if you try to load a
customer address that includes IN as the state, but a Prov/States record does not yet exist for IN,
the system sends a validation error and stops importing.
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Exporting Data From a Form to a Spreadsheet

To quickly create a spreadsheet that contains all the rows in the current form’s grid, including the
header rows, use this process:

1. Inthe form’s grid, select the rows (shift-click in the row numbers on the left):
E Replication Rules =lE ==

Source Sike Target Site Category Source Site: |CAN

Target Site: |BC
Categary: | Site Admin

[rescription:

Note: You can use Ctrl-2 to toggle between the grid view and the form view.
2. Type Ctrl-C to copy the rows to the clipboard.

3. Open a spreadsheet and paste the rows into it. Notice that some columns are empty and some
are set to a different format than appears in the form (for example, 0’s and 1’s instead of

checkboxes).
A | B | C | D | E | F | & [ H | 1

| 1 [SourceSite [+ | TargetSitd v |ReplicationCatego{~ | Description [~]IntervalType [~]Interval [~]Startin{~]Disabld~|UpdateAll
| 2 |CRFP USA Site Admin Transactional 1] 1] 1]
3 |CRFP LISA, Ledger Consolidation Transactional o] o] o]
CAN BC Ledger Consalidation Transactional 0 0 0
CAN BC Shared Currency Transactional 0 0 0
CAN BC Site Adrmnin Transactional 0 0 0

Caution: The Actions > To Excel menu option is also available, but it is intended for export of data to
other applications, not for updating data that will be imported back into Infor CloudSuite. By default,
this option saves the columns in the order they appear in the IDO collection, which may not be the
same order that they appear in the grid. (However, you can choose to match the sequence of col-
umns in the grid.) Also, be aware that cells with data that contains hard and soft returns might not
work as expected with the To Excel option. In addition, the To Excel output might include cells that
are hidden on the grid. Be careful to ensure that the order of the cells are the same as the grid if you
plan to copy the cells back into the application.

Importing Data From a Spreadsheet into a Form

1. Make sure the columns in the spreadsheet are in the same order as the columns in the form’s
grid.

2. In the spreadsheet, select the rows (shift-click in the row numbers on the left).

L a [ B ] c | D | E | F | 6 | H | 1 |
1 [SourceSi~|TargetSitd v |ReplicationCatego{~]Description [+]IntervalType  [+]Interval [+]Startin{~ | Disabld ~ |UpdateAll

2 CRP Site Admin Immediate il il il
CRP Ledger Consalidation Immediate 0 0 0

UZA Site Admin Immediate il il il

ILL Site Admin Immediate il il il

CAL Site Admin Immediate a a a

3. Right-click and select Copy.
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4. Make sure the form is in "Add" mode. that is, the Create a New Object toolbar button is enabled.
5. In the form’s grid, click in the left column of the first empty row:

Replication Rules

g Site  *Target Sil *
ource Site arget i Source Site”

1 CAL CAN ~ Target Site”
2 CAL CRP Category”
3 CAL CRP Description:
4 CAL ILL
5 CAL ILL Interval Type | Immediate
6 CAL ILL nterval:
T CAL L _ Start Interval At:
8 CAL ILL = )
(O Disable Replication

9 -
* ‘ ’|7| O Update All Columns

6. Select Edit>Paste Rows Append. The rows are added in the grid:

Replication Rules

*5 Sit *Te t Sil *
ouree Site e Source Site” | CAN

1 CAL CAN ) Target Site” | ILL
2 CAL CRP Cg'_:-‘gor'f:k Invoice Builder
3 CAL CRP Description:
4 CAL ILL
5 CAL ILL Interval Type | Immediate
6 CAL ILL sierval
T [cAL ILL = Start Interval At
i CAL ILL
(O Disable Replication
A9 CAN CRP
O Update All Columns
A 10 CAN USA
A 11»[CAN il

7. Click the Save button to save the rows.

The copy works only if all the information in the rows is valid and in the proper format. Otherwise, you
get data validation errors and the import stops. See “Requirements for Loading Data From
Spreadsheets” on page 129.

When the system encounters an error, it asks if you want to correct the field. If you answer Yes, the
import stops. If you answer No, the system continues pasting the rest of the rows. When it completes,
you can correct the rows marked with "ne" in the Infor CloudSuite form.
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Appendix D: Removing a Site or Entity
from an Existing System

Note: Be aware that, if you remove a master site, the Multi-Site Customers, ltems, and Vendors forms
and intranet licensing will no longer be available, since these features depend on having a master
site.

The steps below describe removal of a site or entity that exists by itself in an application database.

There currently is no way to remove one site or entity from a multi-site application database. In that
case, you would copy the site to one new database, then copy all of the other sites to another new
database, then remove the original database that previously contained all of the sites. See the steps
for Appendix F, “Copying an Existing Site into an Existing Database (Multiple Sites per Database).
Also see “Problem: After adding a site in a different database, replication is not working” on page 121.
Many of the logical separation steps described below would still apply in that case.

For more information on any step, refer to the online help.

1. If the site/entity currently reports to an entity and general ledger activity has been performed at
the site, do the following:

a. Post and consolidate all journals and the ledger for transactions in the current site. Run the
Ledger Consolidation activity at each site to calculate the ending balances for every account
number at the site and consolidate them up through the old entity hierarchy.

b. Because the full account balances will be closed out and moved, any balances that are to
remain in the old structure must be manually transferred to other sites by journal entries in
both sites. Post and consolidate those journal entries.

2. |If a site is being removed from a reporting hierarchy (that is, it currently reports to an entity) the
Change Reports To utility should be run at the site, with the Reports To field blank.

3. If an entity is being removed from a reporting hierarchy:

a. Run the Change Reports To utility at sites reporting to that entity, to change the hierarchy so
that no sites are reporting to it.

b. If the entity also reported to a higher-level entity, run the Change Reports To utility at the entity
being removed, with the Reports To field blank.

4. Make sure all other users are logged out of the site. If you are removing a master site, all users
must be logged out of all sites on the master sites’ intranet. If the remaining sites are all in one
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10.

application database, and the removed site/entity is the only site/entity not in that database, all
users must be logged out of that application database.

If the site/entity belongs to an intranet that is sharing tables:

a. Go to the master site’s Intranet Shared Tables form and unshare all the shared _all tables.
This adds the shared tables back to all of the sites/entities in the intranet.

b. Go to the master site’s Intranet Shared User Tables form and unshare the shared user tables.
This adds the shared user tables back to all of the sites/entities in the intranet.

c. Atthe site/entity being removed, go to the Sites/Entities form and change the Intranet value to
some other intranet (or make it blank).

d. Ifthe site being removed is the master site for the shared intranet, log into the master site. On
the Intranets form, blank out the Master Site field. This should replicate to all the other sites in
the shared intranet.

If the site being removed uses intranet licensing, deselect the Intranet Licensing check box on
the Sites/Entities form and save the record.

If the site being removed is a master site using intranet licensing, you must also deselect the
Intranet Licensing field at all slave sites and then apply a license at each site.

Caution: Turning Intranet Licensing off at a site requires that a license document be applied to
that site. It may also result in incomplete licensing on that site for some user-created objects,
because the ModuleMembers records created for new and copied forms will have been created
in the master site application database and in the originator's site application database. If
Intranet Licensing at a site is disabled, and if it is not the master site or the site from which the
new or copy action was originated, then the appropriate ModuleMember licensing records for
those user-created forms and IDOs are not present in the application database of that site

Users cannot access sites where you have turned off intranet licensing until you either set up
specific licensing for that site, or set up a new master site with intranet licensing and then reselect
the Intranet Licensing check box at the master and slave sites.

Remove replication rules:

e from other sites and entities to the site/entity being removed
e from the site/entity being removed to other sites and entities.
If the removed site/entity uses a linked server definition to connect to other sites/entities (see step

9 on page 19), change the linked server setup within SQL Server or with the Configuration Wizard
on the database server.

If the remaining sites are all in one application database, and the removed site/entity is the only
site/entity not in that database, use the Update _All Tables form to truncate the _all tables in
each site/entity.

Delete the removed site/entity’s record in the Sites/Entities form at the other sites and entities.

Since the Site Admin category is replicated between all sites/entities, removing the site record
from one site/entity should remove it from all of the others. Verify this at each site/entity.
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1.

12.

13.

14.

15.
16.

17.

18.

19.

20.

21.

You may need to delete data relating to the removed site, so that Infor CloudSuite Industrial will
allow the deletion of the removed site’s records on the Sites/Entities form. If so, an error message
displays information about the problem. You can also use SQL queries to review any data that
references the site/entity, to make sure you are not leaving databases in a state where orphaned
data causes issues with functionality.

Some records for the site are automatically removed by the system. For example, the site’s
record is removed from the Site Groups form.

Site records remaining in _all tables should not cause problems with the application. However,
they do take up space in the database. See step 16.

If the remaining sites are all in one application database, and the removed site/entity is the only
site/entity not in that database, use the View Management and Trigger Management forms to
regenerate the views and table triggers in that application database.

If the site being removed was the master site, specify a new master site (optional). Log into the
site that will be the new master site. On the Intranets form, select the shared intranet. In the
Master Site field, select this site to specify it as the master site for the intranet.

At the master site, delete any references to the removed site in the Sites/Entities form’s Link Info
tab.

In the removed site/entity, delete records for the other sites/entities in the Sites/Entities form. See
the Note above.

Regenerate the replication triggers at all sites/entities.

You may want to use the Update _All Tables utility to truncate and repopulate the _all tables,
deleting references to the removed site. Or you may want to temporarily preserve the site records
in the _all tables for later auditing. If you choose to truncate/repopulate, perform the truncation at
all sites/entities first; then perform the repopulation at all sites/entities. (If you truncated the tables
in step 9, you can skip this step.)

If the site/entity was removed from an intranet with shared _all tables, go to the master site. Open
the Intranet Shared Tables form and re-share the shared _all tables that you unshared in step 5.

If the site/entity was removed from an intranet with shared user tables, go to the master site.
Open the Intranet Shared User Tables form and re-share the shared user tables that you
unshared in step 5.

In the Service Configuration Manager on the utility server, if the removed site’s configurations
were being monitored by TaskMan or the Event Service, remove it from the list of monitored
configurations. If the site’s configuration was the bootstrap configuration for the Replication
services or for the Inbound Bus service, specify a different configuration to use.

In the Configuration Manager on the utility server, remove the site’s configurations from any
configuration groups, and remove or edit the configuration definitions.

Restart the Infor Framework services on the utility server to pick up the configuration changes.

After removing this site/entity from its current system, you might want to add it to another Infor
CloudSuite multi-site system.
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Appendix E: Adding a Site or Entity to an E
Existing Shared Tables
Intranet

After your multi-site system is set up and running, you might need to add a site to it. Use this chart to
find the instructions to use:

New or Existing Adding to a database with See

New site or entity One site per database page 138
New site or entity Multiple sites per database page 21
Existing site or entity One site per database page 142
Existing site or entity Multiple sites per database page 145

To simplify the explanation of this process, we will use these site names in our examples in this
chapter:

e OH is the master site on the existing shared tables intranet.
e Mil and CA are other sites on the intranet.
e [N is the site being added to the intranet.

About Manual Replication

During this process, one of the steps you will perform is manual replication from the master site to the
new site.

Before you can perform manual replication from the master site, site records must already exist in the
target database (the new site) for all sites in the master site’s intranet. That is, if the master site’s
intranet includes OH (the master site), Ml, CA, and KY, and you are adding the new site IN, then you
must create site records in the IN site for OH, MI, CA and KY, before you run manual replication from
the master site (OH) to the new site (IN). You should only fill in the site name and time zone when you
create the other site records at IN. During manual replication, the site records at IN are overwritten
with the information from the site records at OH.
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Add a New Site or Entity to an Existing System (One
Site per Database)

To add a new site or entity with no existing data to an existing multi-site system with a master site and
shared tables intranet, follow these steps. See the relevant chapters earlier in this guide for additional
details about any step.

Note: Back up all existing databases before starting this process.

1.

10.

11.

On the database server, create the additional site or entity database as described in “Create
Additional Site and Entity Databases” on page 16. Do not link the database.

On the utility server, use the Configuration Manager to set up a client configuration for the new
site (named IN using our example), using the steps under “Create Additional Client
Configurations” on page 26.

Apply the same patches to the new database that have been applied to the other databases in the
shared intranet.

If you have UETs defined at other sites in the shared intranet, ensure that the same UET schema
changes are made in the new site.

Use the Trigger Management form to regenerate triggers for all tables in the new site.
Follow the other steps in Chapter 3 to do the following:
e Use the Configuration Manager to set up any new web servers or configuration groups

needed for the new configuration.

e Use the Service Configuration Manager to add event monitoring for the new configuration, if
needed.
e Use the Service Configuration Manager to add TaskMan monitoring for the new configuration.

e Stop and restart the Infor services so they are aware of the new configuration.
Log into the new site (IN), using the SQL sa user name and password.

In the new site (IN), open the License Management form and apply the license. (If you are using
Intranet Licensing for your shared intranet, skip this step.)

In the new site (IN), open the Sites/Entities form and look at the existing record for this site (IN).
The record should include the time zone, an intranet name (probably Demo if this is a new site), a
database name, and a forms database name.

In the new site (IN), in the Sites/Entities form, add site records for all sites that already exist on the
shared intranet. In our example, you would add records for OH, MI, and CA.

Note: In the records for the other sites, only specify a Time Zone. Any information in these
records will be overwritten later, when you run manual replication. See “About Manual
Replication” on page 137 for more information.

In the master site (OH in our example), open the Sites/Entities form and add a site record for the
new site (IN). In this record, specify exactly the same information (Time Zone, Intranet Name,
Database Name, etc.) that is displayed in the IN record at the IN site.
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12. In the master site (OH), in the Sites/Entities form, add Link Info for each site. For example, the
Link Info for the master (OH) site record looks like this:

To Site Linked Server Name
CA usserver1\slutil
IN usserver2\slutil
Ml usserveri\slutil

The Link Info for the CA site record looks like this:

To Site Linked Server Name
IN usserver2\slutil
OH usserver1\slutil
Ml usserveri\slutil

The Link Info for the MI site record looks like this:

To Site Linked Server Name
CA usserver1\slutil
IN usserver2\slutil
OH usserver1\slutil

The Link Info for the new site record (IN) looks like this:

To Site Linked Server Name
CA usserver1\slutil
Mi usserver1\slutil
OH usserver1\slutil

Note: Do not manually update the site records at any of the other existing sites on the intranet.
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13.

14.

15.

16.

17.

18.

In the master site (OH), add a replication rule to send Site Admin data to the new site (IN):
3 | Replication Rules ©

Source Site: |OH

Target Site: |IN
Category: |Site Admin

Deschphion:

Interval Type: [Transactional v
Interval: 0
Start Interval At:
[[] Disable Rephcation
[[] Update Al Columns

In the master site (OH), open the Replication Management form and regenerate replication
triggers.

In the master site (OH), open the Manual Replication Utility and send all Site Admin data from the
master site (OH) to the new site (IN). Clear the Local Site Data Only field.
M anual R ephcabon Utity €
Specify either the Site or the Site Group for the target of the data
Site: [IN v

Site Group: il

Specify the data you want replicated

Cateqgony: | Site Admin W
Create Date: b
Madified D ate: v

ClLocalSteDatalny

[ Replicate ]

In the new site (IN), open the Sites/Entities form and verify that the site records for the other sites
(OH, MI, and CA) were updated.

In the new site (IN), open the Intranet Shared Tables form and verify that tables that are shared in
the other sites now appear to be shared in this site.

Note: Although the tables appear to be shared, they are not actually shared until after you
complete step 18.

In the new site (IN), open the Sites/Entities form and change the Intranet Name to the shared
intranet’s name. After you select the intranet, you will see this message:

At least one Intranet Shared Table where Shared is Yes exists for Intranet that has [Intranet: name].
Processing may require a significant amount of time.

Click OK and save the record.

During the process, several Replication Triggers Regenerated messages are displayed.
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19. Use the View Management and Trigger Management forms at each site and entity to regenerate
the views and table triggers.

20. In the database server for the new site (IN), verify that the shared _all views have been created
and the shared _all tables no longer exist:

Object Explorer « 0 X
Connect ~  4J Y =]
= | IN_App A
+ |_] Database Diagrams
+ | Tables
= Ca

+ [ System Views
dbo.ana_ledger_all
dbo.ana_pertot_all
dbo.apdraftt_all
dbo.apparms_all
dbo.ApplicationModules
dbo.aptrx_all
dbo.aptrxp_all
dbo.ar_terms_due_all
dbo.ARAgIngAmMEDerView
dbo. ARAgingArmtView
dbo. ARAQINgCustYiew
dbo. ARAgingDoView
dbo.ARAGQINgYiew
dbo.arparms_all

dbo. ARSumSimplifiedamtt

|

BEEEEEREREEEEE

Note: Depending on your setup, some _all tables might be shared, and others might not be
shared. In that case, you will still see some _all tables in the Tables node, but the shared _all
tables should not be listed.

21. At this point, you can set up other replication rules in the new site (IN) to/from other sites in the
intranet. See Chapter 5, “Setting Up Replication at Sites and Entities,” for more information.

22. Regenerate the replication triggers after adding the rules.

23. At the new sitelentity, follow the steps in Chapter 7, “Setting Up Accounts and Financial Reporting
Hierarchies to set up the site’s accounting and reporting information.

e For new sites that report to an existing entity, the chart of accounts and accounting periods
should be automatically replicated. In order for this to occur, these conditions must be met:

e The hierarchy between the site and entity must be set up as described in Chapter 7.

e The Ledger Consolidation rule must be set from the entity to the site, and the GL
Replication rule must be set from the site to the entity, and replication triggers must be
regenerated.

e Manual replication of Ledger Consolidation from the entity to the site, and manual
replication of General Ledger from the site to the entity, must be processed.

e For new entities, the chart of accounts and accounting periods must be copied manually as
described in Chapter 7.

e |f some existing sites will report to a new entity, use the Change Reports To Entity utility at
those sites to specify the new reporting hierarchy. Do this after performing all of the other
steps in Chapter 7 and - if there are now multiple levels of entities - after specifying the CTA
account information at the corporate (top-level) entity as described on page 84.
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24. Follow the steps in Chapters 8-12 to finish setting up the new site or entity. You will probably be

copying much of the data from existing sites.

e On the Inter-Site Parameters form, if appropriate, set up relationships between the new site
and the other existing sites that will be transferring items or material to/from the new site. If
Site Admin is being replicated, this information will be added automatically at the other sites.

e On the Order Entry Parameters form, set the invoice length to match the length set at the
other sites.

Add an Existing Site or Entity to an Existing System
(One Site per Database)

To add a site/entity with existing data to an existing multi-site system, follow these steps. See the
relevant chapters in this guide or the online help for additional details about any step.

Before You Start

Back up all existing databases before starting this process.

If the existing site currently reports to an entity and will report to a different entity after moving,
think carefully about the implications.

Also, if the site previously did not report to an entity, but it will now, you must ensure that the site’s
currency, chart of accounts, and so on, match those at the entity.

See the information in the Multi-Site Planning Guide about entities and reporting structures,
especially the information on changes to reporting structures.

Steps

1.

If the site currently is part of another multi-site SyteLine system, follow the steps in Appendix D,
“Removing a Site or Entity from an Existing System." Then return to this page and complete the
following steps.

Follow steps 9 through 16 under “Add a New Site or Entity to an Existing System (One Site per
Database)” on page 138; then return to this process.

To synchronize customer and vendor information at sites:

a. Using SQL queries, find existing vendors and customers in the newly added site that have
matching numbers but different names in existing sites.

b. Atthe added site, use the Move Local Customers and Move Local Vendors utilities to change
customer and vendor numbers at this site to match the number used at existing sites in this
multi-site system. See the online help on these forms for more information about how to use
them.
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c. Ifyou ran the Move Local Customers utility in the previous step, run the Rebalance Customer
Balances utility to update the customers’ posted balance and order balance.

4. Set up replication rules between the new site/entity and the other sites and entities. For more
information, see Chapter 5, “Setting Up Replication at Sites and Entities.”

5. Regenerate the replication rules at all sites and entities.
6. If the added site/entity will report to an entity in its new structure:

a. If chart records exist at the added site/entity that do not exist at the entity it will report to, add
those records to the financial entity.

b. Run the Change Reports To Entity utility at the added site/entity.

e You can only change the Reports To Entity to a financial entity that has the same base
(domestic) currency, Chart of Accounts and accounting periods. Also, the system verifies
that all accounts defined at the site already exist at the financial entity. If this validation
fails, the change will not be allowed and a report is created detailing the failures.

e If no Chart of Accounts, financial statement account templates, or accounting periods
have been set up yet at the site, this Change Reports To Entity utility will copy them from
the entity to the site.

c. Run Ledger Consolidation (again) at each site/entity in the new structure. This consolidates
the beginning balances for each account up through the new financial entity hierarchy.

7. If you are adding an entity:

a. If chart records exist at the existing site/entity that do not exist at the added entity they will
report to, add those records to the entity.

b. Runthe Change Reports To Entity utility at the sites that will report to this entity, specifying the
name of this added entity.

e You can only change the Reports To Entity to a financial entity that has the same base
(domestic) currency, Chart of Accounts and accounting periods as the site. Also, the
system verifies that all accounts defined at the site already exist at the financial entity. If
this validation fails, the change will not be allowed and a report is created detailing the
failures.

e If no Chart of Accounts, financial statement account templates, or accounting periods
have been set up yet at the site, this Change Reports To Entity utility will copy them from
the entity to the site.

c. Run Ledger Consolidation (again) at each site/entity in the new structure. This consolidates
the beginning balances for each account up through the new financial entity hierarchy.

Add a New Site into an Existing Database (Multiple
Sites per Database)

See “Add New Sites and Entities to an Existing Application Database” on page 21.”
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Appendix F: Copying an Existing Site into F

an Existing Database
(Multiple Sites per Database)

Before You Start

Think about these things:

If you have custom tables in your existing sites (possibly created with the SQL Tables form in a
previous version of Infor CloudSuite), they will be copied, but they will not be changed to multi-site
tables. That is, the table name is not changed to xxx_mest, no view is created over the table, and
no multi-site column is added to the table. If you want a custom table to be multi-site, create and
run a script to perform conversions. For more information about the required schema
conversions, see the white paper Coding and Schema Changes Made in SyteLine 9.00 for
Multiple Sites per Database.

Tables or columns that exist in the source must also exist in the target database. So if you have
custom tables or columns in the source, you must make sure they are added to the target.

Use the Analyze Only option (see below) to find additional potential problems that you must
address before you perform the copy. If you do not find and correct these problems, and the copy
process hits a validation error, the copy process is aborted.

Do you have replication document metadata (that is, records in the Replication Documents form
and related forms) that has been customized or revised from the standard Infor metadata? If so,
be aware that this process copies replication document metadata only into a target database that
does not contain any replication document metadata. This could be an empty target database, or
a target database that is emptied during the site copy process, or a target database where all
replication document metadata has been removed.

If replication document metadata exists in the target database, then use the App Document
Metadata Sync utility as described in Step 13 below.

The Infor PCM (BuyDesign) configuration output tables are excluded from this process and are
not copied to the target database by the Infor CloudSuite Configuration Wizard. Run the Infor
Product Configuration Management Configurator Output Database Copy Utility after the Infor
CloudSuite Configuration Wizard has successfully completed the copy process. For more
information about this utility, see KB article 1549052 on Infor Xtreme.
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Steps

To copy an existing site from a (source) application database into another (target) application
database:

1. Disable any replication to the source site for the duration of the copy process. Prevent users from
accessing or making any changes in the source and target databases during the copy.

2 Open the Configuration Wizard.
3 Select Add New Site to an Existing Database and click Next.

Welcomel

‘welcome to the Infor CloudSuite Configuration Wizard, which will guide you through
the configuration process. The list below shows all of the components that can be configured
on thiz server. Select any components that you wish to configure at this time and click Mext
when pou are ready to continue.

Wllowes & new site to be added to a

Component To Configure
database.

[ Create Databases
[ Link D atabases for Multi-Site Uze

LCancel | | Mest » | |

4 In the Select Source Site Type dialog box, select Database and specify the SQL information
about the source database and site.

Select Source Site Type

Specify the zource site type and information to facilitate a copy to the target.

* Databaze ™ Initialized Application Site
SOL Server Mame: |[I0c:a|] j
SOL Username: [sa
SOL Pazsword: [
SOL Database: [CRP_App |
Site I: S

Lancel | < Back | Mest » | |

5 Click Next.
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6

10
11

12
13

14
15

In the Set the Target Database Information dialog box, specify the SQL information about the
target application database into which the site will be copied.

Set the Target Database information H

Specify the enterprize specific information for the Target Databaze.

SOL Server Mame: |USEDVWLD j

SOL Username: [sa
SOL Pazsword: =
SOL D atabase:

SOL Server Partitioning Status: |Partitioning supported

S0L Database Partitioning Status: |N0t Ernpty, Partitioned
[~ Delete Target Database Data [~ Analyze Orly

Lancel | < Back | Mest » | |

Select Analyze Only to compare the two databases (source and target) to identify any problems
that might occur during the copy. Possible problems to be addressed are listed in “Validations” on
page 148.

Select Delete Target Database Data only if you want to empty the data from the specified target
database. This is only necessary if you copy a site within a non-partitioned application database
that contains installed, upgraded add-ons, third-party applications, and/or other customizations to
a target application database that contains no sites, in order to create a partitioned target
application database.

Click Next to review changes.
Click Commit and then click Finish. Review the log file for analysis results.

After any problems are resolved, repeat the steps above and clear Analyze Only so the copy can
be performed. See “What Is Copied” on page 149 for a list of the types of information that is
copied, and exceptions that are not copied.

Click Next and then Commit to complete the process.

The utility copies replication document metadata from the source to the target only if the target
database does not currently contain any replication document metadata. Otherwise, use the App
Document Metadata Sync utility on the utility server to export replication document metadata from
the source database and import it into the target database. In the first screen, select both the
Base SyteLine and Core Access As values. In the second screen, select Replication
Documents. Password parameters are copied from the source database to the target database if
the target database is empty (and therefore does not include password parameters).

Redefine any Full Text Indexes on tables in the target database.
Verify that the site in the target database is working properly and all data was copied correctly.
Then you can delete or archive the source database.

Note: This step assumes that the source database contains only one site. If the source database
has multiple sites, you cannot delete or archive one site from the database.
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Re-licensing the target database

After you perform this procedure, you might need to re-license the target database, depending on
how the source site was originally licensed. Here are some examples where re-licensing might be
required:

If Intranet Shared Licensing is used, the target database looks to the master site for licensing. If
the master site is being moved into the target database, the target database must now be
licensed.

Named user licensing was used at the source site, but concurrent licensing is used in the target
database.

The source was defined as an "entity" database, but the target database currently contains only
"sites" and is not licensed for "entities.”

See the Licensing Guide for more information about licensing setup.

Validations

During the process, these areas of validation are performed:

Is the target database partitioned? If not, in the target (empty) database, foreign keys are
dropped, the partition function is created, partition scheme is created, multi-site tables are
partitioned using the partition scheme, and foreign keys are recreated.

If the target database is already partitioned, the partition scheme and partition function are
updated for the site that is being added.

If user table or _All table sharing is enabled for either the source or target database, then the
source site and all sites in the target database must be on the same intranet. Otherwise, the
process is aborted.

Table compatibility:

e [f a table exists in the source database, but a table with the same name does not exist in the
target database, the process is aborted.

e If a table exists in the target database, but a table with the same name does not exist in the
source database, a warning is logged but the process continues.

User Extended Tables (UET) compatibility:

e |Ifthe Source and Target databases both have UET data, verify its compatibility. If these areas
are not compatible, the process is aborted:

e For fields, no differences in data type, decimals, user-defined datatype, and precision.
e Forindexes, no differences in index uniqueness specification or fields.

e No difference in fields associated with a class.
[ J

For table classes, no differences in table_rule, extend_all_recs, allow_record_assoc, and
active values.

e |If the Target database has UET data that is not impacted, the process is aborted.
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e Ifthereis a unique UET index on a _mst table, the copy process is aborted. You must add the
Site Column Name to the index. (If you plan to later add a unique UET index in this _mst table
with UET fields, you must manually add the site_ref column to this index.)

If any Application Event System events are actively running or queued in the source database,
the process is aborted. The events are listed in the error messages with the name of the event,
the IDO, the table, and the RowPointer.

If any differences are found in these areas for Application Event System events, a message is
logged but the process continues:

e Differences in values for matching EventHandler records

Differences between any matching EventAction values

Event actions that exist for a handler in the source, but not in the target, or vice versa
EventActionVariableAccess values that differ between the source and target

For an event, sequence, event action sequence, and variable name, any rows that exist in the
source, but not in the target, or vice versa

e Table names that start with “Import” and table names that contain “SourceDL” or “TargetDL”
are excluded from the process.

What Is Copied

During the process, this data is copied from the source to the target database:

UET definitions. Only the impacted schema changes are copied. If the source database has UET
data that has not been impacted, it is not copied. The schema is impacted at the target if
necessary. (See above for validation information.)

All multi-site tables except AccountAuthorization_mst, user_local_mst, and UserGroupMap_mst.
If these three tables are not shared, then they are copied like any other multi-site table. If these
tables are shared, they are processed like other user tables, based on the type of sharing being
done (see below).

All non-multi-site tables. Some tables require special processing:

e Notes: Internal token numbers that overlap are renumbered. If the same note text exists in
both the source and target databases, after the copy there are duplicate notes in the target.

e Documents: Sequence numbers that overlap are renumbered.
e Service schedules (see above for validation information)
e Application Event System data:

e New Event rows are copied from source to target

e New EventMessageCategory are copied from source to target
e New EventinitialState rows are copied from source to target
[ ]

If anything is different in EventlinitialVariables for an existing EventlInitialState record, the
state is renamed when it is copied to the target. For example, xxx becomes xxx2. The
copied event handlers are also changed to use the new initial state name.

e New EventlnitialVariable are copied from source to target, as well as existing rows that
required a newly renamed EventinitialState record.
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e Users and Groups: What is copied depends on the type of sharing, if any, currently being
done between the source site and the target database:

e No sharing of user tables between source and target: for tables where Userld is part of the
unique key, copy the unique records; if duplicate user IDs exist, use the record from the
target.

e If all sites are on the same intranet, the source site is a subordinate site and the target
database contains a master site: For tables where Userld is part of the unique key, copy
the unique records; if duplicate user IDs exist, ignore the duplicates, remapping Userld
during the process for comparison.

e |If all sites are on the same intranet, the source site is the master site, and the target
database contains only subordinate sites: Drop the view in the target database, and copy
the source table into the target database. For tables where Userld is part of the unique
key, copy the unique records; if duplicate user IDs exist, ignore the duplicates, remapping
Userld during the process for comparison.

e |If all sites are on the same intranet, the source site is a subordinate site, and the target
database contains only subordinates sites: For tables where Userld is part of the unique
key, copy the unique records; if duplicate user IDs exist, ignore the duplicates, remapping
Userld during the process for comparison.

e UserPasswordHistory: If users are shared, this table is always shared. If users are not
shared, and the user already exists in the target database, the history is not copied. If the user
does not exist in the target database, the history is copied.

e Replication document metadata is copied from the source to the target only if the target database
does not currently contain any replication document metadata.

e Custom (non-Infor CloudSuite) tables, either multi-site or not multi-site. To copy a non-multi-site
custom table, the copy process requires a unique constraint on the table, and it tries to move any
data from the source to the target that does not already exist in the target, based on this
constraint.

e Updates site.app_db_name to the database name of the target database

e Updates site_link_info.linked_server_name to the server name of the target database for all rows
where site_link_info.to_site = site being moved

Data within some tables, for example AuditLog, BGTaskHistory _mst, and tables whose names start
with "import" is not copied with this process.

If the source site is in a database that contains other sites, the data is filtered so that only the
specified site’s data is copied.
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About the Ultility

This utility copies user data and authorizations from one Infor CloudSuite database to another Infor
CloudSuite database. This can save time in setting up users in the additional databases.

If your target database is multi-site, the utility copies user data and authorizations to the database. For
shared user tables that end with _mst (that is, AccountAuthorizations_mst, UserGroupMap_mst, and
User_local_mst) one copy is made to the master site. For non-shared user tables that end with _mst,
a copy is made for each site in the database. Other user tables (UserNames, UserEmail,
GroupNames, UserModules, and UserDefinedFields) are also copied. For exceptions to this, see
“How the Utility Handles Shared User Tables” on page 155.

The UserTables.txt file in the SyteLine folder on the utility server is provided by Infor. This file lists
tables that are commonly copied by this utility. The Copy User Tables utility refers to this file to
determine which tables to copy. You can edit this file to remove tables from the list if you do not want
them to be copied by the utility. Adding tables to the list is not supported.

Caution: If any users are already defined in the target database, those users are deleted by this util-
ity. Any Foreign Key references are also deleted. Therefore only use this utility in these cases:

e You have created a new demo or initialized database, and you want to copy all user data and
authorizations from a site in an existing database to sites in the newly created database.

e You have a pilot database (for example, Phase 1 Pilot). In Phase 2 Pilot testing, you want to
replace the entire Phase 1 Pilot database with fresh data. However, you want to copy the user
data from the Phase 1 Pilot database into the Phase 2 Pilot database, so that you do not have to
re-enter all of the user information.

e You have a test database with a limited set of users who can access it, but the test data has
become stale or corrupted. You want to copy a "live" production database to create a new version
of the test database, but you do not want to allow all of the users in the production database to
access the test database. You can use this utility to wipe out the user information in the copy, and
replace it with the user data from the previous test database.
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Using the Utility

1. To open the utility on a Windows Server 2008 utility server, select Start > All Programs > Infor >
Tools > Copy User Table.

To open the utility on a Windows Server 2012 utility server, find Copy User Table under Apps.
Run the utility as an administrator.

2. In the Source tab, specify the SQL server, SQL login ID and password to access the source
database.

3. Select the source database. This must be an Infor CloudSuite 9.00.xx application database.
e |If the source database is not sharing user tables, you can select any site in that database as

the source for the copy.

e If the source database is sharing user tables and the master site is not in that database, an
error message is displayed and you must select a different source database.

e If the source database is sharing user tables and the master site is found in the database, the
message "Intranet Shared User Tables detected" is displayed.

If you get this message, click OK. Note that the status field is updated.
B Copy User Tables - SQL 2008 £t

Source ]Target] Login |

S0L Server Mame |USCD\SLBUU j

SQL Server Login ID |dgcco

S0L Server Login |m

Password

I UseWindows Authenticaion

Source Database |DH_A|::|:: jJ

Source Site |g|-| j
Status

Source Database: Internet Shared User Tables detected.

Dropped UserModules Records

Copy Close

4. |If this is a multi-site source database, select the source site. If there is a master site, only the
master site can be selected.

If this is a single-site source database, the source site is selected by default.

5. In the Target tab, the SQL server name, login ID and password values are defaulted from the
previous tab, but you can change them.

152 | Infor CloudSuite Industrial - Multi-Site Implementation Guide



Copy User Tables Utility

Select a target database. This must be an Infor CloudSuite 9.00.xx application database. It
cannot be the same database as the source database.

If the target database is sharing user tables and the master site is not in that database, an
error message is displayed and you must select a different source database.

If the target database is sharing user tables and the master site is found in the database, the
message "Internet Shared User Tables detected" is displayed. If you get this message, click
OK. Note that the status field is updated.

If this is a multi-site target database that is sharing user tables, only the master site is
displayed and selected in the Target Site field.

If this is a single-site target database, the target site is selected by default.

If this is a multi-site database that is not sharing user tables, all of the sites that will receive the
copied user data are listed.

In this example, SP_20_Midwest_App is a multi-site database with two sites, Ml and OH:

Copy User Tables - SQOL 2008 -

Source Target ] Login ]

S0L Server Mame |U550\5L9|JD j
SQL Server Login ID |dc|c:CD
SQL Server Login |m

Password
™ UseWindows Authentication

Target Database SP20_Midwest_App hd J

Wl ~
OH hd

2 Target Site(s) |

Status

Dropped UserModules Records

Copy Close
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7. In the Login tab, specify an Infor CloudSuite user ID, password, and the name of any Infor
CloudSuite configuration in the target database:

B Copy User Tables - SQL 2008 -

Suurce]Target Login l

User ID |sa
Password E—
Data Source Config |0|—| 90020 j

Mote: The Data Source Config should pointto the TARGET database. License |D
is obtained from the TARGET database for re-encrypfion of UserModuleSpec.

Status

Dropped UserModules Records

Copy Close

8. Click Copy.

The Dropped UserModules Records field Its only populated when a license is in place. It lists the
UserModules records that exceeded the license and had to be dropped.

Troubleshooting

UsernamesColumns.count does not match between databases

If you get an error similar to this, the schema of the specified table is different in the source and target
database. One of the tables has additional columns.

ExecuteNonQuery failed for Database ‘dbname’

If you get an error similar to this, ensure that you have set up a configuration that matches the name
specified in the Data Source Config field.
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How the Utility Handles Shared User Tables

There are several different options for setting up user table sharing on the Intranet Shared User
Tables form. The Copy User Tables utility checks to see if any of these tables are shared in either the
source or target database:

AccountAuthorizations_mst

UserGroupMap_mst

User_local_mst

Other user tables (UserNames, UserEmail, GroupNames, UserModules, and UserDefinedFields)

If any of these tables is shared in the source database, then only the master site in that database can
be used as the source site for the copy utility.

The sharing setup in the target database determines which tables are copied to which sites in the
target database. In the scenarios below, the database pictures show any shared tables across the
top.

e All user tables are shared in a target database with a master site.

If all of the user tables listed above are shared, and the master site is in the target database, the
utility copies the user tables only to the master site in the target database.

AccountfAuthorizations_mst
user_local_mst
\other non_mst user tables /
R —

Site 1

site 2 Site 3

Master

~_ 1 |~

e _mst user tables are not shared in the target database.

If the three _mst user tables listed above are not shared in a multi-site target database, then the
utility copies those user tables to each site in the target database.

<7wj/

Site 1 "

Master Site 3
user_local_mst Site 2 user_|ocal_mst
UserGroupMap_mst user_local_mst UserGroupMap_mst
AccountAuthorizations_mst UserGroupMap_mst AccountAuthorizations_mst

\ AccountAuthorizations_mst
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User_local_mst is not shared in a target database with a master site.

If AccountAuthorizations_mst and UserGroupMap_mst are shared, but user_local_mst is not
shared in a multi-site target database with a master site, the utility copies just the user_local_mst
user table to each site in the target database. AccountAuthorizations_mst and
UserGroupMap_mst are only copied to the master site. The other user tables are copied to the
database..

UserGroupMap_mst
AccountAuthorizations_mst

\mher non_mst user tables //

-

Site 1

. Site 3
Master Site 2

user_|local_mst user_local_mst
user_|ocal_mst - -

S~ -

User_local_mst is not shared in a target database with no master site.

If you attempt to copy user tables into a target database that is sharing user tables, but the master
site is not in that target database, an error will occur.

In order to copy user tables into this target database, you must first turn off the sharing of user
tables in the master site, use the copy utility to copy the users to the target database, and then
turn sharing back on.

T
~

Site 1 -
Site 2 Site 3

user_local_mst user_local_mst
user_local_mst - -

S~ -
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Appendix H: Upgrading a Multi-Site
System

To upgrade from Infor CloudSuite version 7 or 8, see the Infor CloudSuite Industrial Installation Guide
chapter on upgrading an Infor CloudSuite database. Follow the steps in that chapter to upgrade each
of your application databases.

To migrate an Infor CloudSuite version 5 or 6 multi-site environment to Infor CloudSuite Industrial 9,
see the Infor CloudSuite Industrial Installation Guide chapter on migrating from Infor CloudSuite 5 or
Infor CloudSuite 6 (multi-site). Follow the steps in that chapter to migrate each of your application
databases.

Note: If you plan to keep all of your sites in separate databases, then stop here and do not continue
with the steps below.

Converting a Multi-Site, Multi-Database System to a
Multi-Site, Single Database System

After reading the information in the Multi-Site Planning Guide, if you want to convert from a multi-site,
multi-database system to a multi-site, single database system, use these steps:

Note: SQL Server Enterprise Manager must be installed on the target database server.

1. If you are on a previous version of Infor CloudSuite, upgrade each of your site databases to the
current version (Infor CloudSuite 9.00 or above). See the Installation Guide for instructions.

2. If you have any business partner add-on products, upgrade those products on each of your site
databases. See the appropriate product guide for instructions.

3. On the target database server, use the Infor CloudSuite Configuration Wizard to create a new,
empty application database that will contain the sites and entities in your new multi-site, single
database system. This database is automatically partitioned when it is created.

4 Follow the steps in Appendix F, “Copying an Existing Site into an Existing Database (Multiple
Sites per Database).
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5 After all sites are copied, use the View Management and Trigger Management forms to
regenerate the views and table triggers in all application databases.
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